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บทที ่1 
บทน า 

1.1 ความเป็นมาและความส าคัญของปัญหา 

ในปัจจุบันมีองค์กรที่มีระบบที่พัฒนาจากภาษาต่างๆ ส าหรับใช้ในการจัดการหรือด าเนิน
ธุรกิจขององค์กรที่แตกต่างกันเป็นจ านวนมาก ซึ่งเมื่อเวลาผ่านไป ในองค์กรนั้นอาจมีระบบเก่า 
(Legacy System) ที่ล้าสมัยไม่สามารถตอบสนองต่อการเปลี่ยนแปลงความต้องการทางธุรกิจ  ไม่มี
ประสิทธิภาพเพียงพอหรือยังมีความผิดพลาดเกิดขึ้น หรือมีปัญหาจากไม่สามารถรองรับเทคโนโลยี
ใหม่ เช่น ในเรื่องของการจัดการข้อมูล เรื่องความปลอดภัย รวมทั้งมีบุคลากรน้อยที่มีความรู้ภาษาเก่า
ที่ใช้พัฒนาระบบเหล่านั้น ดังนั้น จึงมีการรื้อปรับระบบ (Reengineering) ขององค์กรให้เป็นระบบที่
ใช้ภาษาใหม่ในการพัฒนา เพ่ือตอบสนองต่อความต้องการทางธุรกิจที่เป็นปัจจุบัน อย่างไรก็ตาม การ
รื้อปรับระบบใหม่จ าเป็นต้องมีการเก็บรวบรวมความต้องการ การวิเคราะห์   และออกแบบ ซึ่งเป็น
หน้าที่ของนักวิเคราะห์ระบบหรือนักพัฒนาระบบ  ซึ่งต้องใช้ระยะเวลาและความพยายามท าความ
เข้าใจกับระบบเก่า 

ภาษาพีแอลเอสคิวแอล (PL/SQL: Procedural Language SQL) เป็นภาษาโปรแกรมที่ใช้ใน
การพัฒนาซอฟต์แวร์ทางธุรกิจพัฒนาโดยบริษัทออราเคิล (ORACLE) ตั้งแต่ปี 1988 ซึ่งเป็นตัวเชื่อม
ระหว่าง เทคโนโลยีฐานข้อมูลและการโปรแกรมเชิงกระบวนงาน (Procedural Programming) ที่ใช้
ใน Software Oracle Developer Tools ส าหรับสร้างออกแบบฟอร์มหรือออกหน้ารายงาน เพ่ือให้
เป็นไปตามความต้องการของผู้ใช้ โดยใช้ภาษาพีแอลเอสคิวแอลในการจัดการกับข้อมูล ในปัจจุบันยัง
มีหลายองค์กรทีใ่ช้ซอฟต์แวร์นี้ในการพัฒนาและบ ารุงรักษาระบบ  อย่างไรก็ตาม เพื่อให้ตอบสนองต่อ
การเปลี่ยนแปลงความต้องการทางธุรกิจและรองรับเทคโนโลยีใหม่ๆ องค์กรจ าเป็นต้องมีการ
ปรับเปลี่ยนระบบใหม่ซึ่งการรื้อปรับระบบต้องมีการท าความเข้าใจระบบเดิมเพ่ือให้สามารถวิเคราะห์
และออกแบบระบบใหม่ที่สามารถท างานแทนที่ระบบเดิมได้ 

งานวิจัยนี้ได้ท าการศึกษาลักษณะการท างาน และรูปแบบโครงสร้างของภาษาพีแอลเอสคิว
แอล เพ่ือน าเสนอแนวทางและพัฒนาเครื่องมือสร้างแผนภาพจ าลองภาพรวมการออกแบบระบบเดิมที่
พัฒนาด้วยโปรแกรมเชิงกระบวนงานที่ใช้ใน Oracle Developer Tools ทั้งนี้ แนวทางที่น าเสนอจะ
ช่วยลดระยะเวลาในการท าความเข้าใจระบบจากเอกสารและตัวโปรแกรมระบบเดิม ลดความ
ผิดพลาดในขั้นตอนของการวิเคราะห์ออกแบบและการพัฒนาระบบซอฟต์แวร์ใหม่จากระบบ
ซอฟต์แวร์เดิมที่ให้ผลลัพธ์การท างานเหมือนเดิม 

1.2 วัตถุประสงค์ของการวิจัย 

น าเสนอวิธีการและพัฒนาเครื่องมือส าหรับดึงคอนเซปต์การออกแบบระบบเดิมที่พัฒนาด้วย
ภาษาโปรแกรมเชิงกระบวนงานเพื่อช่วยการท าความเข้าใจในการรื้อปรับระบบ  
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1.3 ขอบเขตของการวิจัย 

1. เครื่องมือที่พัฒนาขึ้นรองรับการดึงคอนเซปต์การออกแบบระบบเดิมที่พัฒนาด้วยภาษา
โปรแกรมเชิงกระบวนงาน คือ ภาษาพีแอลเอสคิวแอล 

2. รองรับข้อมูลน าเข้าประกอบด้วย Form (.fmb), Report (.rdf), Library (.pll), Menu 
(.mmb) จาก Oracle Developer Tools Version 10g 

1.4 ข้อตกลงเบื้องต้น 

1. เอกสารเอกซ์เอ็มไอเป็นไปตามข้อก าหนดของเอกซ์เอ็มไอเวอร์ชัน 2.0 ของโมเดลลิโอ 
3.0.0 [1] 

2. แผนภาพคลาสเป็นไปตามข้อก าหนดของยูเอ็มแอลเวอร์ชัน 2.4.1 

3. ข้อมูลน าเข้าจะต้องผ่านฟังก์ชันของ Oracle Developer Tools 

1.5 ประโยชน์ที่คาดว่าจะได้รับ 

ได้วิธีการและเครื่องมือที่ช่วยท าความเข้าใจการออกแบบระบบเดิมที่พัฒนาด้วยภาษาพีแอล
เอสคิวแอล ส าหรับการรื้อปรับระบบให้เป็นระบบใหม่ที่ตอบสนองความต้องการทางธุรกิจขององค์กร
และรองรับเทคโนโลยีในปัจจุบัน 

1.6 วิธีด าเนินงานวิจัย 

1. ศึกษาและท าความเข้าใจโครงสร้าง ค าสั่ง และการท างานของ Oracle Developer 
Tools และภาษาพีแอลเอสคิวแอล 

2. ศึกษาและท าความเข้าใจทฤษฎีที่เก่ียวข้อง 

3. ศึกษาและท าความเข้าใจงานวิจัยที่เกี่ยวข้อง 

4. วิเคราะห์และก าหนดระเบียบวิธีวิจัย 

5. ออกแบบ ตั้งสมมติฐาน ก าหนดเป้าหมาย และก าหนดตัวแปรที่เก่ียวข้องกับงานวิจัย 

6. พัฒนาเครื่องมือการดึงคอนเซปต์ภาพรวมการออกแบบระบบเพื่อช่วยการรื้อปรับระบบ 

7. ทดสอบและประเมินผลงานวิจัยตามวัตถุประสงค์ท่ีก าหนด 

8. สรุปผลงานวิจัย และน าผลที่ได้ไปปรับปรุงระบบเพื่อให้ได้ตามวัตถุประสงค์ที่ก าหนด 

9. ตีพิมพ์ผลงานวิจัย 

10. จัดท ารูปเล่มวิทยานิพนธ์ 
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1.7 ผลงานที่ตีพิมพ์จากวิทยานิพนธ์ 

ส่วนหนึ่งของวิทยานิพนธ์นี้ได้รับการตีพิมพ์ในรายงานสืบเนื่องจากการประชุมวิชาการระดับ
น าน าช าติ เ รื่ อ ง  “Model-Driven Concept Extraction from Procedural Source”, Napas 
Methakullawat and Yachai Limpiyakorn, in Proceedings of 2013 International 
Conference on Advanced Software Engineering & Its Applications, Jeju Island, Korea, 
Nov 21-23, 2013, pp. 246-252., และตีพิมพ์ในวารสารวิชาการนานาชาติ เรื่อง “Reengineering 
Legacy Code with Model Transformation”, Napas Methakullawat and Yachai 
Limpiyakorn, International Journal of Software Engineering and Its Applications, vol. 
3,no. 4, (2014), pp. 65–87 

1.8 ล าดับการจัดเรียงเนื้อหาในวิทยานิพนธ์ 

วิทยานิพนธ์นี้แบ่งเนื้อหาออกเป็น 6 บท ดังต่อไปนี้ บทที่ 1 บทน า กล่าวถึงความเป็นมาและ
ความส าคัญของปัญหา วัตถุประสงค์ของการวิจัย ขอบเขตของการวิจัย ประโยชน์ที่คาดว่าจะได้รับ
และผลงานตีพิมพ์ บทที่ 2 กล่าวถึงทฤษฎีและงานวิจัยที่เกี่ยวข้องของงานวิจัย บทที่ 3กล่าวถึง
วิธีด าเนินการวิจัย บทที่ 4 กล่าวถึง การออกแบบและพัฒนาระบบตามแนวทางการวิจัย บทที่ 5 
กล่าวถึงวิธีการประเมินและวัดผลการทดลอง และบทที่ 6 สรุปผลการวิจัย ข้อเสนอแนะ และแนวทาง
ส าหรับการวิจัยต่อในอนาคต 

 

 

 

 

 

 



บทที ่2  
ทฤษฎีและงานวิจัยที่เกี่ยวข้อง 

2.1 ทฤษฎีที่เกี่ยวข้อง 

2.1.1 ภาษาพีแอลเอสคิวแอล (PL/SQL Language: Procedural Language SQL)[2] 

ภาษาพีแอลเอสคิวแอลถูกพัฒนาขึ้นตั้งแต่ปี ค.ศ. 1988 เป็นภาษาโปรแกรมที่ใช้ในการ
พัฒนาซอฟต์แวร์ทางธุรกิจของออราเคิลด้วย Oracle Developer Tools ประกอบด้วยเครื่องมือย่อย 
คือ 

1. Form Builder ส าหรับสร้างและออกแบบฟอร์ม  

2. Report Builder ส าหรับสร้างรายงาน 

3. Graphic Builder ส าหรับสร้างแผนผัง แผนภูมิ 

4. Designer ส าหรับออกแบบเค้าโครงฟอร์มและรายงานในเบื้องต้นแบบอัตโนมัติ 

ภาษาพีแอลเอสคิวแอลเป็นภาษาโปรแกรมเชิงกระบวนงาน ใช้พัฒนาระบบงานที่เพ่ิม
ความสามารถให้กับเอสคิวแอล (SQL: Structured Query Language) ของออราเคิล ท าให้สามารถ
พัฒนาระบบงานที่สลับซับซ้อน และเข้าถึงหรือจัดการข้อมูลในฐานข้อมูลได้เป็นอย่างดี ด้วย
ความสามารถของภาษาพีแอลเอสคิวแอล ผู้ใช้สามารถใช้ค าสั่งภาษาจัดการข้อมูลหรือดีเอ็มแอล 
(Data Manipulation Language DML) เ พ่ือท า กา ร  แทรก ( insert)  ลบ  (delete)  อัพ เดท 
(update) หรือ เลือก (select) ข้อมูลในฐานข้อมูล รวมทั้งสามารถใช้ค าสั่งลูป (Loop) เพ่ือท างาน
แบบวนซ้ า หรือใช้ค าสั่ง if และ case เพ่ือตรวจสอบเงื่อนไขค าสั่งเอสคิวแอลได ้

โครงสร้างของภาษาพีแอลเอสคิวแอล (ภาพที่ 1) แบ่งเป็น 4 ส่วน (Block) หลัก 
ประกอบด้วย 

1. หัวข้อ (Header)  

2. การประกาศ (Declaration)  

3. การประมวลผล (Execution) และ  

4. ข้อยกเว้น (Exception) 

ภาพที่ 2 แสดงตัวอย่างการเขียนกระบวนงานประกอบด้วย 4 ส่วน ในส่วนแรก Header มี
การตั้งชื่อว่า get_happy รับพารามิเตอร์เข้า ส่วนที่สอง Declaration มีการประกาศตัวแปรชนิดวันที่ 
ส่วนที่สาม Execution มีสมการค านวณค่าและค าสั่งจัดการแทรกข้อมูลในตาราง (Table) ของ
ฐานข้อมูล DML insert และส่วนสุดท้าย Exception เป็นส่วนข้อยกเว้นเมื่อมีการบันทึกข้อมูลซ้ าลง
ในตาราง จะแสดงข้อความ “Cannot insert” 
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ภาพที่ 1 โครงสร้างบล็อคของภาษาพีแอลเอสคิวแอล 

 

 
ภาพที่ 2 ตัวอย่างการเขียนกระบวนงานของภาษาพีแอลเอสคิวแอล 

 

 

 
ภาพที่ 3 ตัวอย่างการเขียนฟังก์ชันของภาษาพีแอลเอสคิวแอล 
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ภาพที่ 3 แสดงตัวอย่างการเขียนฟังก์ชันซึ่งไม่มีส่วน Exception ส่วนแรก Header มีชื่อว่า 
booktitle  มีการรับพารามิเตอร์และส่งค่ากลับ (Return) ส่วนที่สอง Declaration มีการประกาศตัว
แปร และตารางชั่วคราว (Cursor) ส่วนที่สาม Execution มีการดึงข้อมูลจากตารางชั่วคราวมาเก็บที่
ตัวแปร เมื่อมีการเรียกฟังก์ชันก็จะท าการส่งค่ากลับ ภาพที่ 4 แสดงตัวอย่างการเขียนส่วนประมวลผล
เพ่ือแสดงข้อความ “Hello world” โดยไม่มีส่วน Header, Declaration, และ Exception 

 
ภาพที่ 4 ตัวอย่างการเขียนส่วนประมวลผลโดยไม่ต้องมีส่วน Header, Declaration, และ 

Exception 

2.1.2 แผนภาพคลาส (Class diagram) [3] 

แผนภาพคลาส คือ แผนภาพท่ีใช้แสดงคลาสและความสมัพนัธ์ (Relationship) ในแง่มุมต่างๆ 
ได้แก่ ความสมัพันธ์เชิงสถิต (Static Relationship) คือ ความสัมพันธ์ท่ีมีอยู่แล้วปกติในระหว่างคลาส 
แผนภาพคลาสสามารถใช้เพ่ือช่วยวิเคราะห์ระบบวา่ประกอบด้วยสว่นตา่งๆ หรือคลาสอะไรบ้าง ซึง่แตล่ะ
คลาสก็มีลกัษณะหน้าท่ีเฉพาะตน และมีความสมัพนัธ์กบัคลาสอื่นๆในรูปแบบตา่งๆ ภาพท่ี 5 แสดงการ
ประยกุต์ใช้แผนภาพคลาสเพ่ือแสดงเมตาโมเดลของแผนภาพคลาสยเูอม็แอล 

 
ภาพที่ 5 การน าเสนอ metamodel of UML Class diagram ด้วยแผนภาพคลาส 

2.1.3 เอกซ์เอ็มแอล (XML: eXtensible Markup Language) 

เอกซ์เอ็มแอล เป็นภาษาที่ออกแบบมาเพ่ือให้สามารถนิยามข้อมูล  ซึ่งผู้ใช้งานสามารถสร้าง
แท็กขึ้นเองได้ และแท็กที่สร้างขึ้นเองนั้นจะเป็นมาตรฐานที่ผู้ใช้ก าหนดขึ้น XML สามารถรองรับการ
ใช้งานจากภาษาคอมพิวเตอร์อ่ืนๆ ได้ ไม่ว่าจะเป็น ASP, VB, PHP, JavaScript เพราะแท็กที่ผู้ใช้
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สร้างขึ้นไม่ได้ท าหน้าที่แสดงข้อมูล แต่ท าหน้าที่ระบุขอบเขตของข้อมูล เอกสารเอกซ์เอ็มแอลจะมีการ
อธิบายข้อมูลด้วยรูปแบบโครงสร้างที่เป็นล าดับชั้น (Hierarchy) เหมือนต้นไม้ (Tree) ท าให้สามารถ
สร้างโปรแกรมประยุกต์เพ่ือท าการประมวลผลเอกสารและต่อประสาน (Binding)  ผู้รับผิดชอบและ
ก าหนดมาตรฐานของเอกซ์เอ็มแอล คือ World Wide Web Consortium (W3C) เอกซ์เอ็มแอ
ลประกอบด้วยส่วนหลัก คือ 

 ตัวเอกสารเอกซ์เอ็มแอลซึ่งเป็นโครงสร้างทางตรรกะ (Logical Structure) อธิบาย
คุณลักษณะต่างๆ ของข้อมูลที่บรรจุอยู่ในเอกสารในลักษณะโครงสร้างล าดับชั้น ดัง
แสดงในภาพที่ 6 

 การก าหนดกฎและรายละเอียดของเนื้อหาเอกสารหรือที่เรียกว่า ดีทีดี (DTD: 
Document Type Declaration) และเอกซ์เอ็มแอลสคีมา (XML Schema) ท า
หน้าที่ในการก าหนดไวยากรณ์ของเอกสารเอกซ์เอ็มแอลที่มีรูปแบบถูกต้อง (Well-
formed document) ดังแสดงในภาพที่ 7 

 

 
ภาพที่ 6 ตัวอย่างลักษณะโครงสร้างล าดับชั้นของเอกสาร XML 
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ภาพที่ 7 ตัวอย่าง XML Schema ชื่อ “shiporder.xsd” 

2.1.4 DOM (Document Object Model) [4] 

DOM เป็นมาตรฐานของ W3C ก าหนดขึ้นเพ่ือใช้ในการเข้าถึงเอกสาร ตัวอย่างเช่น เอกซ์เอ็ม
แอล และ เอ็ชทีเอ็มแอล แบ่งออกเป็น 3 มาตรฐานที่แตกต่างกัน ดังนี้ 

1. Core DOM เป็นแบบจ าลองมาตรฐานส าหรับทุกๆ โครงสร้างเอกสาร 

2. XML DOM เป็นแบบจ าลองมาตรฐานส าหรับเอกสารเอกซ์เอ็มแอล 

3. HTML DOM เป็นแบบจ าลองมาตรฐานส าหรับเอกสารเอ็ชทีเอ็มแอล 

โครงสร้างของ DOM ประกอบด้วย 

 Document node คือ โนดส าหรับเอกสารทั้งหมด 

 Element node คือ โนดส าหรับทุก ๆ XML elements 

 Text node คือ ค่าท่ีเก็บอยู่ใน XML elements 

 Attribute node คือ โนดส าหรับทุก ๆ แอทริบิวต์ 

 Comment node คือ โนดส าหรับ comments 

ภาพที่ 8 แสดงตัวอย่าง XML DOM ซึ่งถูกสร้างขึ้นเพ่ือใช้อธิบายการเข้าถึงและจัดการกับ 
XML Document โดยจะมองเอกสารเอกซ์เอ็มแอลในรูปแบบของโครงสร้างต้นไม้ เรียกว่า โนดทรี  
(node-tree) ทุกโนดสามารถเข้าถึงภายใต้โครงสร้างต้นไม้เพ่ือเข้าไปจัดการกับข้อมูลภายใน โนดทรี
ประกอบด้วยกลุ่มของโนดรวมถึงการเชื่อมต่อกันของแต่ละโนด เริ่มต้นจากโนดราก (root node) คือ 
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bookstore และแตกกิ่งก้านไปจนถึงเท็กซ์โนด (text node) ซึ่งเป็นโนดล่างสุดของโครงสร้างต้นไม้ 
ดังแสดงในภาพที่ 9 เงื่อนไขของโครงสร้างต้นไม้มีทั้งหมด 5 ข้อ ดังนี้ 

1. โนดที่อยู่บนสุดเรียกว่า ราก (root) 

2. ทุกโนดจะต้องมีโนดพ่อแม่ (Parent Node) ยกเว้นโนดราก 

3. หนึ่งโนดใดๆ จะสามารถมีลูกกี่โนดก็ได้ 

4. ใบ ( Leaf ) จะต้องไม่มีโนดลูก 

5. ซิบลิงส์ (Siblings) จะต้องเป็นโนดที่อยู่ในระดับเดียวกัน 

 
ภาพที่ 8 ตัวอย่าง XML DOM 

 
ภาพที่ 9 ตัวอย่าง XML DOM Node Tree 
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2.2 งานวิจัยท่ีเกี่ยวข้อง 

2.2.1 Legacy Systems Reengineering Using Software Patterns [5] 

งานวิจัยนี้ ได้น าเสนอวิธีการรื้อปรับระบบเก่าโดยใช้แบบแผนซอฟต์แวร์ ( software 
patterns) มาช่วยในการรื้อปรับระบบ ดังแสดงในภาพที่ 10 ประกอบด้วยขั้นตอนแรก คือ น าเข้า
ระบบเก่าผ่านเครื่องมือกระบวนการย้อนกลับ (Reverse Engineering) ได้ผลลัพธ์เป็นโครงสร้างของ
โปรแกรม หรือข้อมูลของฐานข้อมูล ซึ่งอยู่ในลักษณะแบบจ าลองเชิงวัตถุ (Object Model) ขั้นที่สอง 
ผ่านกระบวนการรู้จ า (Recognition) แบบแผนซอฟต์แวร์ โดยรายการแบบแผนนั้นจะข้ึนอยู่กับระบบ
เก่าว่า ควรใช้แบบแผนในลักษณะใด หลังจากกระบวนการรู้จ าแบบแผนซอฟต์แวร์ จะได้แบบจ าลอง
เชิงวัตถุของระบบที่ตรงกับแบบแผน (System Object Model with pattern) ขั้นตอนสุดท้าย น า 
Toolkits หรือ Framework มาช่วยจัดการในการพัฒนาระบบ 

 

 
ภาพที่ 10 วิธีการรื้อปรับระบบเก่าด้วยแบบแผนซอฟต์แวร์ 

2.2.2 Representing Procedural Source in UML [6] 

งานวิจัยนี้ได้น าเสนอแนวคิดวิธีการแปลงโปรแกรมจากภาษาต้นทางให้เป็นภาษาโปรแกรม
เป้าหมายโดยการใช้ MDA (Model Driven Architecture) [7] ซึ่งเป็นวิธีการแปลงผ่านแบบจ าลอง 
(Model) ดังแสดงในภาพที่ 11 เริ่มต้นด้วยขั้นตอนการดึงองค์ประกอบของรหัสต้นทาง (source 
code) ต้นทางมาสร้างเป็นแบบจ าลองเฉพาะแพลตฟอร์มหรือพีเอสเอ็ม (Platform Specific 
Model PSM) ตัวอย่างเช่น EJB  (Enterprise JavaBeans) PSM เป็นแบบตัวอย่างของระบบในแง่
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โครงสร้างของ EJB ของจาวา ซึ่งประกอบด้วย home interface, entity bean, session bean เป็น
ต้น หลังจากนั้นจะท าการดึงคอนเซปต์จากพีเอสเอ็มต้นทางเพ่ือสร้างเป็นแบบจ าลองที่ไม่ชึ้นกับ
แพลตฟอร์มหรือพีไอเอ็ม (Platform Independent Model PIM) ซึ่งจะถูกน าเข้ากระบวนการ
แปลงอิงโพรไฟล์ ร่วมกับการเทียบ (mapping) องค์ประกอบของพีเอสเอ็มต้นทาง เพ่ือสร้างเป็นพีเอส
เอ็มเป้าหมาย ขั้นตอนสุดท้าย คือ การสร้างโค้ดโปรแกรมภาษาเป้าหมายจากแบบจ าลองเฉพาะ
แพลตฟอร์มเป้าหมายที่ได้จากข้ันตอนก่อนหน้า  

 
ภาพที่ 11 ขั้นตอนการแปลงโปรแกรมจากภาษาหนึ่งเป็นอีกภาษาด้วย Model Driven 

Architecture 

 

 

 



บทที่ 3  
วิธีด าเนินการวิจัย 

3.1 แนวคิดวิธีการด าเนินการวิจัย 

งานวิจัยนี้ได้ประยุกต์ใช้ Model-driven Architecture เพ่ือเป็นแนวทางในการดึงคอนเซ
ปต์การออกแบบของระบบเดิมที่พัฒนาด้วยภาษาที่ไม่ตอบสนองต่อความต้องการทางธุรกิจในปัจจุบัน 
เพ่ือช่วยลดระยะเวลาของนักวิเคราะห์ระบบหรือนักพัฒนาระบบในการท าความเข้าใจกับระบบเดิม 
โดยงานวิจัยนี้ได้น าเสนอวิธีการและพัฒนาเครื่องมือที่แสดงแผนภาพจ าลองการออกแบบของระบบ
เก่าที่พัฒนาด้วยภาษาพีแอลเอสคิวแอล ซึ่งเป็นภาษาโปรแกรมเชิงกระบวนงานที่ใช้ใน  Oracle 
Developer Tools ส าหรับสร้างแบบฟอร์มและรายงาน ซึ่งในการพัฒนานั้นเลือกการพัฒนา
ซอฟต์แวร์จากอีคลิปส์ [8] เนื่องจากเป็นโอเพนซอร์สมีความเหมาะสมในการประยุกต์ใช้งานและ
พัฒนาต่อยอด รวมทั้งสะดวกให้นักวิจัยท่านอ่ืนได้น าข้อมูลเข้าในรูปแบบจาร์ไฟล์ (JAR FILE) ในการ
พัฒนานั้นจะแยกฟังชั่นหลักออกเป็นในแต่ละแพ็คเกจ (Package) เป็นหมวดหมู่เพ่ือสะดวกในการ
ติดตั้งใช้งาน วิธีการที่น าเสนอเริ่มต้นจากการแปลงรหัสต้นทางภาษาโปรแกรมต้นทางให้อยู่ในรูปแบบ
เอกซ์ เ อ็มแอล ด้ วยการน า รหั สต้นทางที่ ได้ จาก  Oracle Developer Tools ได้ แก่  ฟอร์ ม 
(.fmb:Form), รายงาน (.rdf:Report), เมนู (.mmb:Menu) น ามาผ่านฟังก์ชัน Form2XML จะได้
ไฟล์น าเข้าที่อยู่ในรูปแบบเอกซ์เอ็มแอล ดังตัวอย่างในภาพที่ 13 และ ไลบรารี (.pll:Library) ดังภาพ
ที่ 14 จะได้ไฟล์น าเข้าที่อยู่ในรูปแบบพีแอลดี (PLD) หลังจากได้ข้อมูลน าเข้าที่อยู่ในรูปแบบเอกซ์เอ็ม
แอลแล้ว จะท าการดึงข้อมูลนั้นมาจัดเก็บและวิเคราะห์ โดยใช้วิธีการ MDA แล้วท าการเทียบค่าให้อยู่
ในรูปแบบเมตาโมเดลเอกซ์เอ็มแอล ส าหรับน าเข้า Visualization Tool ได้แก่ โมเดลลิโอ[6] เพ่ือ
แสดงแผนภาพคลาสที่จ าลองการออกแบบภาพรวมของระบบ และรายงานสรุปข้อมูลสถิติ เช่น 
จ านวนตาราง จ านวนฟังก์ชัน จ านวนกระบวนงาน จ านวนความสัมพันธ์ระหว่างวัตถุ เพ่ือตรวจสอบ
ความครบถ้วนของผลลัพธ์การรื้อปรับระบบ ภาพรวมการท างานระบบ แสดงดังภาพที่ 12  

3.2 การแปลงไฟล์ข้อมูลน าเข้าให้อยู่ในรูปแบบเอกซ์เอ็มแอล 

 การแปลงไฟล์ข้อมูลน าเข้าเริ่มต้นด้วย การส่งออกข้อมูลน าเข้าที่ได้จากซอฟต์แวร์ Oracle 
Developer Tools ซึ่งได้แก่ 1) ฟอร์ม มีองค์ประกอบที่ส าคัญคือ แสดงโมดูลในส่วนของการกรอก
ข้อมูล แสดงกราฟฟิค ข้อความแจ้งเตือน และการเรียกใช้ฟังก์ชันหรือกระบวนงาน 2) ไลบรารี มี
องค์ประกอบที่ส าคัญคือ แพ็คเกจของฟังก์ชันและกระบวนงาน 3) เมนู มีองค์ประกอบที่ส าคัญคือ 
เมนูหลัก เมนูย่อย และข้อมูลเมนู 4) รายงาน มีองค์ประกอบที่ส าคัญคือ ข้อมูลน าเข้า ข้อมูลส่งออก 
สูตรค านวณ สรุปข้อมูล และฟังก์ชันค านวณ ซึ่งในแต่ละไฟล์นั้น จะมีองค์ประกอบที่แตกต่างกัน มี
ลักษณะเฉพาะตัวและมีความสัมพันธ์ซึ่งกันและกัน หลังจากส่งออกข้อมูลน าเข้าแล้ว น ามาผ่าน
ฟังก์ชัน  Form2XML ซึ่ ง เป็นฟังก์ชันส่ วนเสริมของ Oracle Developer Tools โดยเรียกใช้  
Form2XML.bat ผ่าน Command Prompt แปลง ฟอร์ม, เมนู, รายงาน ให้อยู่ในรูปแบบของเอกซ์
เอ็มแอล ดังภาพที่ 13 และ ไลบรารี อยู่ในรูปแบบพีแอลดี ดังภาพที่ 14 
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ภาพที่ 12 ภาพรวมการท างานระบบ 

 
ภาพที่ 13 ตัวอย่างเอกซ์เอ็มแอลของฟอร์มที่ผ่านกระบวนการแปลง 

 
ภาพที่ 14 ตัวอย่างพีแอลดีของไลบรารีที่ผ่านกระบวนการแปลง 
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ตารางที่ 1 อิลิเมนต์ของเอกซ์เอ็มแอลที่ส าคัญในการสกัดข้อมูล 

XML Tag Tag’s Attributes Extracted 

AttachedLibrar

y 

Name, LibrarySource, LibraryLocation 

Function Name, ReturnType 

ModuleParamete

r 

Name, ParameterInitializeValue 

LOV Name, RecordGroupName, Title 

Item Name, DatabaseItem, DatabaseType, ItemType, 

CanvasName 

Program Unit Name, ProgramUnitType, ProgramUnitText 

Block Name, DirtyInfo, QueryDataSourceName, 

UpdateAllowed 
UserParameter Name, DataType, InitialValue 

Trigger Name, Dirtyinfo, TriggerText  

xmlSettings xmlTag, xmlPrologType 

RecordGroup Name, RecordGroupType, RecordGroupQuery 

FORM 

FormModule Name, ConsoleWindow, MenuModule, Title 

Graphics Name, GraphicsText 

Alert Name, DirtyInfo, Title, AlertMessage, 

Button2Label 
Form Method, Action 

MENU 

MenuModule Name, DirtyInfo, MainMenu 

MenuItem Name, DirtyInfo, SubMenuName, MenuItemCode, 

CommandType, Label 

LIBRARY 

Section Name, Orientation 

TextSegment Name, DirtyInfo, FontName 

REPORT 

Field Name, Source 

Report Name, DirtyInfo, DTDVersion 

Summary Name, Source, Function, Compute, Reset 

BinaryData Encoding, DataId 

Formula Name, Source, DataType, BreakOrder 

DataSourceColu

mn 

Type, DSCType, DSCName, DSCMandatory 
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ภาพที่ 15 ตัวอย่างข้อมูลรูปแบบอาร์เรย์ลิสของฟอร์มที่ถูกสกัดองค์ประกอบ 

 
ภาพที่ 16 ตัวอย่างข้อมูลรูปแบบอาร์เรย์ลิสของเมนูที่ถูกสกัดองค์ประกอบ 

 
ภาพที่ 17 ตัวอย่างข้อมูลรูปแบบอาร์เรย์ลิสของรายงานที่ถูกสกัดองค์ประกอบ 
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ภาพที่ 18 ตัวอย่างข้อมูลรูปแบบอาร์เรย์ลิสของไลบรารีที่ถูกสกัดองค์ประกอบ 

3.3 การสกัดองค์ประกอบของข้อมูลน าเข้า 

 การสกัดองค์ประกอบของข้อมูลน าเข้ามีข้ันตอนดังภาพที่ 19 โดยข้อมูลน าเข้านั่นจะต้องผ่าน
ฟังก์ชันเพ่ือให้อยู่ในรูปแบบเอกซ์เอ็มแอล และรูปแบบพีแอลดี จากนั้นใช้หลักการ DOM ในการสกัด
องค์ประกอบข้อมูลน าเข้าที่อยู่ในรูปแบบเอกซ์เอ็มแอล ส่วนในรูปแบบพีแอลดี จะใช้คีย์เวิร์ดที่ส าคัญ
ในการสกัดข้อมูล โดยมีอิลิเมนต์ที่ส าคัญในการสกัดองค์ประกอบ ตามตารางที่ 1 ในตารางส่วนแรก
เป็นส่วนเอกซ์เอ็มแอลแท็กทั่วไป ที่มีอยู่ในฟอร์ม เมนู ไลบรารี และรายงาน ส่วนที่เหลือจะแบ่งตาม
ประเภท เมื่อสกัดองค์ประกอบจะถูกเก็บข้อมูลไว้อยู่ในรูปแบบอาร์เรย์ลิสของฟอร์ม เมนู รายงาน 
และไลบรารี ดังภาพที่ 15 , ภาพที่ 16 , ภาพที่ 17 และ ภาพที่ 18 ตามล าดับ หลังจากนั้น ขั้นตอน
สุดท้ายการแจงส่วนข้อมูลอาร์เรย์ลิส จะได้ข้อมูลคีย์ตารางแฮชและข้อมูลที่ผ่านการแจงส่วนเพ่ือไปใช้
ในกระบวนการถัดไป 

DOM Document Build

DOM Tree

Extract All Element

Store elements in ArrayList

Parse ArrayList Data

XML , PLD

Hash 
Table 
Keys

XML 
Required 
Elements

 
ภาพที่ 19 ขั้นตอนการสกัดองค์ประกอบของข้อมูลน าเข้า 
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3.4 การแปลงข้อมูลน าเข้าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ (XMI: XML Metadata 
Interchange) 

 การแปลงข้อมูลน าเข้าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ  ชนิดแบบจ าลองไม่ขึ้นกับ
แพลตฟอร์ม มีข้ันตอนดังภาพท่ี  21 และประกอบด้วย 2 ขั้นตอนหลักดังนี้ 

 
ภาพที่ 20 เมตาโมเดลของ 4 ส่วนหลักของพีแอลเอสคิวแอล 

Validate Data

Find Relationship?

Store Data in XMIvariable 

Mapping XMI

Generate XMI

Hash 
Table 
Keys

Parsed 
Data

Metamodel 
PL/SQL

Yes

No
Log File

 
ภาพที่ 21 ขั้นตอนการแปลงข้อมูลน าเข้าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ 
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3.4.1 การตรวจสอบความสัมพันธ์ระหว่างไฟล์น าเข้า 

 การตรวจสอบความสัมพันธ์ระหว่างไฟล์น าเข้า หลังจากได้ข้อมูลคีย์ส าคัญตารางแฮชและ
ข้อมูลที่ผ่านการแจงส่วนแล้ว เริ่มต้นด้วยขั้นตอนตรวจสอบข้อมูล เพ่ือตรวจสอบหาความสัมพันธ์ของ
ภาพรวมระบบและความสัมพันธ์ภายในของไฟล์น าเข้า โดยความสัมพันธ์เทียบค่าได้จากตารางที่ 2 
โดยแต่ละไฟล์ประกอบด้วยคีย์ส าคัญ เพ่ือเทียบหาค่าความสัมพันธ์ระหว่างกัน ในกรณีไม่พบ
ความสัมพันธ์จะท าการจัดเก็บข้อมูลไว้ที่ล็อกไฟล์ (Log file) หลังจากนั้นท าการเทียบค่ากับเมตา
โมเดลของพีแอลเอสคิวแอล ตามภาพท่ี 20  

ตารางที่ 2 คียต์ารางแฮชส าหรับตรวจสอบความสัมพันธ์ส่วนหลัก 
Relationship[I]:  

Form’s Key Menu’s Key 

< FormName > < MenuItem > < SubMenuItem > 

< FormParameter> < MainParameter > 

Relationship[II]: 

Form’s Key Report’s Key 

< FormReport > < ReportName > 

< FormParameter> < UserParameter > 

Relationship[III]: 

Form’s Key Library’s Key 

< AttachedLibrary > < NameLibrary > 

< FormProgramUnit > < LibProcedure > < LibFunction > < LibPackage > 

< FormText > < LibProcedure >  < LibFunction > 

Relationship[IV]: 

Library’s Key Report’s Key 

< LibProcedure > < LibFunction > < NameReport >  < Formula >  

< LibParameter > < UserParameter > 

Define Priority

Generate XMI ID

Create Map Rule

Map Data XMIvariable

 
ภาพที่ 22 ขั้นตอนการเทียบค่าให้อยู่ในรูปแบบเอกซ์เอ็มไอ 
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3.4.2 การเทียบค่าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ 

 การเทียบค่าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ ชนิดแบบจ าลองไม่ขึ้นกับแพลตฟอร์ม 
เพ่ือให้ได้เมตาโมเดลเอกซ์เอ็มไอ ที่จะแสดงภาพรวมความสัมพันธ์ของระบบความสัมพันธ์ระดับสูง 
(High Level)  และแสดงรายละเอียดความสัมพันธ์ระดับต่ า (Low Level) ของแต่ละเอกซ์เอ็มไอ มี
ขั้นตอนดังภาพที่ 22 เริ่มต้นขั้นตอนด้วยการก าหนดล าดับความส าคัญ (Priority) ของแต่ละส่วน เพ่ือ
ใช้ในการหาความส าคัญล าดับก่อนหลังของความสัมพันธ์เอกซ์เอ็มไอ หลักจากนั้นสร้างรหัสประจ าตัว
ของเอกซ์เอ็มไอ และท าการเทียบค่าเอกซ์เอ็มไอต่อไป โดยเอกซ์เอ็มไองานวิจัยนี้รองรับการท าง าน
ของซอฟต์แวร์โมเดลลิโอ 3.0.0  

ตารางที่ 3 แท็กส าหรับการเทียบค่าเอกสารเอกซ์เอ็มไอ 
XMI TAGS ORACLE TAGS 

<packagedElement> <Form> <Menu> <Report> < Block> <LOV> <Item>  

<AttLibrary>  <Procedure>  <Relation> <Function> 

<Trigger> <Report> <Group> <Library> <ProgramUnit> 

<Field> <Section> <Data> <Formula> <LayOut> 

<DataSource> <select> <UserParameter> 
<ownedAttribute> <Name> < ID> <Parameter> <Type> <input> <output> 

<Library> <procedure> <function> <cmdType> <Unit 

Text> <Condition> <Source> <Query> <Module> 

<ReturnTYpe> <InitialValue> <DataType> <content> 
<ownedEnd> < Association> <type> 

<lowerValue> Lower Priority <tag> number of element 

<upperValue> Higher Priority <tag> number of element 

<type > <Class><Property> <primitiveType> 

 เมื่อความสัมพันธ์ทั้งหมดถูกค้นพบ หลังจากนั้นจะน ามาสร้างเอกซ์เอ็มไอในรูปแบบแผนภาพ
คลาส โดยมีแท็กท่ีส าคัญของเอกสารเอกซ์เอ็มไอโมเดลลิโอ ดังตารางที่ 3 ประกอบด้วย 6 อย่างคือ 

1. packagedElement เป็นแท็กที่ให้รายละเอียดของแผนภาพคลาสได้แก่ ประเภทของ
แผนภาพ รหัสประจ าตัวของแผนภาพ และชื่อของแผนภาพ ตัวอย่างแสดง ดังภาพที่ 23 

 

<packagedElement  xmi:id="_wNqo6aFzEd6Eo8cPzRliQg"xmi:type="uml

:Class" name="SLTR0020" > 
 

ภาพที่ 23 ตัวอย่าง packagedElement 

2. ownedAttribute เป็นแท็กที่ให้รายละเอียดของคุณสมบัติของอิลิเมนต์ได้แก่ ประเภท
ของแอททริบิวต์ รหัสประจ าตัวของแอททริบิวต์ ชื่อของแอททริบิวต์ การรวมกลุ่ม และ
ความสัมพันธ์ ตัวอย่างแสดง ดังภาพที่ 24 และภาพท่ี 25 
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<ownedAttribute xmi:type="uml:Property"xmi:id="_W2l2saHzEeOUK

5PElNDnww" type="_W2l24qHzEeOUK5PElNDnww"aggregation="shared"

 association="_W2l2t6HzEeOUK5PElNDnww"> 
 

ภาพที่ 24 ตัวอย่าง ownedAttribute แสดงคุณสมบัติของความสัมพันธ์ 

 

<ownedAttribute xmi:type="uml:Property"xmi:id="_W2l2yKHzEeOUK

5PElNDnww" name="Query" isUnique="false"> 
 

ภาพที่ 25 ตัวอย่าง ownedAttribute ย่อยในคลาสอิลิเมนต์ 

3. ownedEnd เป็นแท็กที่ ให้รายละเอียดของความสัมพันธ์ระหว่างอิลิ เมนต์ได้แก่  
ประเภทพของแผนภาพ รหัสประจ าตัวของแผนภาพ และความสัมพันธ์ ดังภาพที่ 26 

 

<ownedEnd xmi:type="uml:Property" xmi:id="_W2l2uKHzEeOUK5PEl

NDnww"type="_W2l2sKHzEeOUK5PElNDnww" association="_W2l2t6HzE

eOUK5PElNDnww"> 

<upperValue xmi:type="uml:LiteralUnlimitedNatural"xmi:

id="_W2l2uaHzEeOUK5PElNDnww" value="*"/> 

</ownedEnd> 

  
ภาพที่ 26 ตัวอย่าง ownedEnd 

4. lowerValue เป็นแท็กที่ให้รายละเอียดของจ านวนความสัมพันธ์ของอิลิเมนต์ตัวเอง
ได้แก่ ประเภทของค่า รหัสประจ าตัวของค่า และจ านวนค่าความสัมพันธ์ ดังภาพที่ 27 

 

<lowerValue xmi:type="uml:LiteralUnlimitedNatural"xmi:id="_W

2l2uaHzEeOUK5PElNDnww" value="*"/>  
ภาพที่ 27 ตัวอย่าง lowerValue 

5. upperValue เป็นแท็กที่ให้รายละเอียดของจ านวนความสัมพันธ์ของอิลิ เมนต์ตรงข้าม
ได้แก่ ประเภทของค่า รหัสประจ าตัวของค่า และจ านวนค่าความสัมพันธ์ ดังภาพที่ 28 

 

<upperValue xmi:type="uml:LiteralUnlimitedNatural"xmi:id="_W

2l2uaHzEeOUK5PElNDnww" value="2"/> 
 

ภาพที่ 28 ตัวอย่าง upperValue 

6. type เป็นแท็กที่ให้รายละเอียดของ ownedAttribute ได้แก่ ประเภทของแอททริบิวต์ 
และชนิดของแอททริบิวต์ ดังภาพที่ 29 

 

<type xmi:type="uml:PrimitiveType"href="http://www.omg.org/s

pec/UML/20100901/PrimitiveTypes.xmi##String"/>  
ภาพที่ 29 ตัวอย่าง type 

 กฏในการแปลงภาพให้อยู่ในรูปแบบเอกซ์เอ็มไอ มีดังนี้ 

  1. ถ้าเป็น packagedElement ให้ด าเนินการดังต่อนี้ 

 ก าหนดรหัสตามล าดับของแพ็คเกจ 
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 ก าหนดชื่อแพ็คเกจ 

 ก าหนดประเภทของแพ็คเกจได้แก่ Class, Association, Aggregation, 
Composition, Generalization 

 ก าหนดรหัสของ memberEnd 

2. ถ้าเป็น ownedEnd ให้ด าเนินการดังต่อไปนี้ 

 ก าหนดรหัสตามล าดับของ ownedEnd 

 ก าหนดประเภทของ xmiType  

 ก าหนดประเภทของ ownedEnd เป็นรหัสส าหรับหาความสัมพันธ์ 

 ก าหนดรหัสของ Association 

3. ถ้าเป็น ownedAttribute ให้ด าเนินการดังต่อไปนี้ 

 ก าหนดรหัสตามล าดับของ ownedAttribute 

 ก าหนดชื่อของ ownedAttribute 

 ก าหนดประเภทของ xmiType 

 ก าหนดประเภทของ ownedAttribute เป็นรหัสส าหรับหาความสัมพันธ์ 

 ก าหนดประเภทของ Aggregation ได้แก่ Shared, Composite 

 ก าหนดรหัสของ Association 

 ก าหนดค่าให้กับ UpperValue 

 ก าหนดค่าให้กับ LowerValue 

4. ถ้าเป็น eAnnotations ให้ด าเนินการดังต่อไปนี้ 

 ก าหนดรหัสตามล าดับของ eAnnotaion 

 ก าหนดประเภทของ xmiType 

 ก าหนด xmiID 

 ก าหนด Source 

 ก าหนด Eproperty 

5. ถ้าเป็น contents ให้ด าเนินการดังต่อไปนี้ 

 ก าหนดรหัสตามล าดับของ contents 

 ก าหนดประเภทของ xmiType 
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 ก าหนด xmiID 

 ก าหนดชื่อของ contents  

3.5 การสร้างรายงานข้อมูลสถิติ  

หลังจากการแปลงข้อมูลให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ ขั้นตอนสุดท้ายคือการสร้าง
ข้อมูลสถิติในรูปแบบรายงานเอกซ์เซล มีข้อมูลน าเข้าคือ ข้อมูลที่ผ่านการแจงส่วนในขั้นตอนที่ผ่านมา 
น ามาเก็บรวบรวมเพ่ือสรุปและอธิบายข้อมูลในส่วนต่างๆ ของส่วนหลักได้แก่  ฟอร์ม, รายงาน, 
ไลบรารี และเมนู  โดยรายงานประกอบด้วยข้อมูล 2 ประเภทคือ 

1. ภาพรวมรายงานสถิติ (Overall statistical reports) จะแสดงภาพรวมความสัมพันธ์
ของระบบความสัมพันธ์ระดับสูง ของข้อมูลน าเข้าชนิดต่างๆ มีรายละเอียดดังต่อไปนี้ 

ส่วนที่แสดงรายละเอียดจ านวน 

- Overview Name ชื่อของภาพรวมระบบ 

- ID รหัสประจ าตัวของข้อมูลน าเข้า 

- NAME ชื่อของข้อมูลน าเข้า 

- TYPE ประเภทของข้อมูลน าเข้า (ฟอร์ม, ไลบรารี, รายงาน และเมนู) 

- PROCEDURES แสดงจ านวนของกระบวนงาน 

- FUNCTIONS แสดงจ านวนของฟังก์ชัน 

- PROGRAM UNITS แสดงจ านวนของโปรแกรมยูนิต 

- RELATIONSHIP แสดงจ านวนของความสัมพันธ์ 

- MISSING ITEMS แสดงจ านวนสิ่งที่ผิดพลาดหรือขาดหาย 

- PARAMETER แสดงจ านวนของพารามิเตอร์ 

- RESULT ผลลัพธ์ของการตรวจสอบความสัมพันธ์ 

ส่วนที่แสดงความสัมพันธ์และรายละเอียด 

- PROCEDURES RELATION แสดงรายละเอียดของส่วนที่มีความสัมพันธ์กัน
โดยกระบวนงาน 

- FUNCTIONS RELATION แสดงรายละเอียดของส่วนที่มีความสัมพันธ์กัน
โดยฟังก์ชัน 

- OTHERS RELATION แสดงรายละเอียดของส่วนที่มีความสัมพันธ์กันใน
แบบอ่ืน 

- MISSING แสดงรายละเอียดของส่วนขาดหายในระบบ 
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- INVALID RELATIONSHIP แสดงรายละเอียดการตรวจสอบสิ่งที่ผิดพลาด
หรือขาดหาย 

2. รายละเอียดรายงานสถิติ (Detailed statistical reports) จะแสดงรายละเอียดความ
ความสัมพันธ์ระดับต่ า   โดยแสดงรายละเอียดของข้อมูลน าเข้าตามชนิดนั้นๆ มี
รายละเอียดดังต่อไปนี้ 

รายละเอียดรายงานของฟอร์ม 

- ATTACHED LIBRARY แสดงจ านวนและรายละเอียดของไลบรารีที่เรียกใช้ 

- BLOCKS แสดงจ านวนและรายละเอียดของบล็อค 

- PROCEDURE แสดงจ านวนและรายละเอียดกระบวนงานของฟอร์ม 

- FUNCTIONS แสดงจ านวนและรายละเอียดฟังก์ชันของฟอร์ม 

- LIST OF VALUE (LOV) แสดงจ านวนและรายละเอียดของ LOV 

- RECORD GROUP แสดงจ านวนและรายละเอียดของ RECORD GROUP 

- TRIGGER แสดงจ านวนและรายละเอียดของตัวกระท า 

- ITEMS แสดงจ านวนและรายละเอียดของ ITEMS 

รายละเอียดของรายงาน 

- USER PARAMETER แสดงจ านวนและรายละเอียดพารามิเตอร์ 

- FORMULA แสดงจ านวนและรายละเอียดของฟอมูลาร์ 

- SECTION แสดงจ านวนและรายละเอียดของเซคชัน 

- FIELD แสดงจ านวนและรายละเอียดของฟิลด์ 

- FUNCTION แสดงจ านวนและรายละเอียดของฟังก์ชัน 

- SELECT แสดงจ านวนและรายละเอียดของ SELECT 

- GROUP แสดงจ านวนและรายละเอียดของกลุ่ม 

- DATA ITEM แสดงจ านวนและรายละเอียดของรายการขอ้มูล 

รายละเอียดของเมนู 

- MAIN MENU แสดงจ านวนและรายละเอียดของเมนูหลัก 

- SUB MENU แสดงจ านวนและรายละเอียดของเมนูย่อย 

- MENU ITEM แสดงจ านวนและรายละเอียดของรายการเมนู 

รายละเอียดของไลบรารี 

- PACKAGE แสดงจ านวนและรายละเอียดของแพ็คเกจ 
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- PROCEDURE แสดงจ านวนและรายละเอียดของกระบวนงาน 

- FUNCTION แสดงจ านวนและรายละเอียดของฟังก์ชัน 



บทที่ 4  
การออกแบบและพัฒนาระบบ 

4.1 สถาปัตยกรรมระบบ  

ระบบที่พัฒนาขึ้นแบ่งออกเป็น 3 ส่วนหลัก คือ 1) ส่วนการสกัดองค์ประกอบของข้อมูล
น าเข้า 2) ส่วนของการเทียบค่าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ 3) ส่วนของการสร้างรายงาน
ข้อมูลสถิต ิในแต่ละส่วนมีการพัฒนาออกจากกันอยู่ในแพ็คเกจของจาร์ในอีคลิปส์ โดยในแต่ละส่วนจะ
มีความสัมพันธ์กัน แสดงดังภาพที่ 12  ระบบจะเริ่มต้นด้วยการน าข้อมูลน าเข้าคือไฟล์ต้นฉบับที่
ส่งออกจากซอฟต์แวร์ Oracle Developer Tools น ามาผ่านฟังก์ชันเสริม Form2xml เพ่ือให้ได้ไฟล์
น าเข้าที่อยู่ในรูปแบบเอกซ์เอ็มแอล จากนั้นน าไฟล์น าเข้าผ่านกระบวนการสกัดองค์ประกอบ ท าการ
หาความสัมพันธ์ระหว่างไฟล์น าเข้า ข้อมูลสถิติต่างๆจะถูกจัดเก็บ เพ่ือตรวจสอบหาความสัมพันธ์ ที่
ผิดพลาดหรือความสัมพันธ์ที่ขาดหายของไฟล์น าเข้า สุดท้ายจะได้ข้อมูลการเทียบค่าเมตาโมเดลเอกซ์
เอ็มไอของพีแอลเอสคิวแอล ชนิดแบบจ าลองที่ไม่ขึ้นกับแพลตฟอร์ม โดยจะแสดงภาพรวม
ความสัมพันธ์ระดับสูง และ แสดงรายละเอียดความสัมพันธ์ระดับต่ า  ของแต่ละเอกซ์เอ็มไอ ข้อมูล
ทั้งหมดจะถูกจัดท ารายงานข้อมูลสถิติของไฟล์น าเข้าแต่ละชนิด แสดงผลลัพธ์การตรวจสอบหา
ความสัมพันธ์ ถ้าเกิดกรณีมีความสัมพันธ์ที่ผิดพลาดหรือขาดหายเกิดขึ้น รายงานจะบ่งชี้ว่าขาด
ความสัมพันธ์ที่ขาดหาย ซึ่งผลลัพธ์ที่ได้คือเมตาโมเดลเอกซ์เอ็มไอ และรายงาน สามารถน าไป
ประยุกต์ใช้งานในด้านอ่ืนๆ เช่น น าเอกสารเอกซ์เอ็มไอ ผ่าน Visualization Tool ในที่นี้คือโมเดลลิ
โอ 3.0.0 เพ่ือแสดงแผนภาพคลาสของข้อมูลความสัมพันธ์ หรือในอนาคตสามารถน าเอกสารเอกซ์เอ็ม
ไอ ผ่านกระบวนการนึงเพ่ือให้ได้เวอร์ชันไฟล์ที่รองรับโปรแกรมสร้างรหัสต้นทางอัตโนมัติ เพ่ือช่วยลด
ระยะเวลาในการออกแบบและสร้างระบบ 

4.2 สภาพแวดล้อมและเครื่องมือที่ใช้ในการพัฒนา 

สภาพแวดล้อมและเครื่องมือที่ใช้ในการพัฒนาระบบประกอบด้วยรายการฮาร์ดแวร์และ
ซอฟต์แวร์ดังต่อไปนี้ 

4.2.1 สภาพแวดล้อม 

1. คอมพิวเตอร์แมคบุ๊คโปร รุ่นกลางปี 2012 

2. หน่วยประมวลผลอินเทล คอร์ไอเซเว่น 2.30 กิกะเฮิร์ต 

3. หน่วยความจ า 16 กิกะไบต์ 

4. ฮาร์ดดิสก์ไดรฟ์ความจุ 500 กิกะไบต์ 

5. ระบบปฎิบัติการแมคโอเอสเอกซ์ 10.8.3 แบบ 64 บิท และระบบปฎิบัติการไมโครซอฟต์
วินโดว์ 7 แบบ 64 บิท 
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4.2.2 เครื่องมือที่ใช้ในการพัฒนา 

1. อีคลิปส์ เวอร์ชันเคปเลอร์ 4.3.2 [9] 

2. เครื่องมือออราเคิลเดฟเวอร์ลอพ 10g 

3. ชุดเครื่องมือพัฒนาจาวา 7 

4. โมเดลลิโอ 3.0.0 

4.3 การพัฒนาระบบ 

การพัฒนาระบบนั้น ส่วนต่างๆ ในระบบจะถูกพัฒนาโดยซอฟต์แวร์อีคลิปส์เป็นเครื่องมือและ
มีการติดตั้งปลั๊กอินพีโอไอเพ่ือให้งานร่วมกันในการสร้างรายงาน ระบบที่ได้จะอยู่ในลักษณะของจาร์
ไฟล์ ซึ่งประกอบด้วยแพ็คเกจแต่ละส่วนงานที่แยกออกจากกันอย่างชัดเจนตามแนวคิดของ
ส่วนประกอบร่วม 

4.3.1 การติดตั้งซอฟต์แวร์ในการพัฒนาระบบ 

 หลังจากเตรียมเครื่องมือส าหรับพัฒนาระบบเรียบร้อยแล้ว จึงท าการติดตั้งเครื่องมือ ทั้งหมด
ลงในเครื่องคอมพิวเตอร์ที่ใช้พัฒนาระบบ โดยมีล าดับขั้นตอนต่อไปนี้ 

1. ติดตั้งซอฟต์แวร์พาราเรล 8 ส าหรับจ าลองการท างานของวินโดว์ 7 

2. ติดตั้งระบบปฎิบัติการ ไมโครซอฟต์วินโดว์ 7 แบบ 64 บิทลงในพาราเรล 8 

3. ติดตั้งเครื่องมือออราเคิลเดฟเวอร์ลอพ 10g 

4. ติดตั้งชุดเครื่องมือพัฒนาจาวา 7 

5. ติดตั้งอิคลิปส์ เวอร์ชันเคปเลอร์ 4.3.2 

6. ติดตั้งโมเดลลิโอ 3.0.0 

4.3.2 การสร้างจาวาโพรเจกต์ (Java project) อีคลิปส์ (Eclipse) 

 การสร้างจาวาโพรเจกต์อีคลิปส์ เริ่มจากเราท าการเลือกสร้างโพรเจกต์ใหม่ แล้วเลือกสร้างจา
วาโพรเจกต์ ดังภาพที่ 30 

หลังจากนั้นจะเป็นการก าหนดรายละเอียดจาวาโพรเจกต์ที่เราสร้างขึ้นมาได้แก่ การก าหนด
ชื่อโพรเจกต์และรายละเอียดการสนับสนุนของอีคลิปส์ ดังภาพที่ 31 

 การก าหนดชื่อของโพรเจกต์และรายละเอียดสนับสนุนของอีคลิปส์ ประกอบไปด้วย
รายละเอียดที่ส าคัญคือ การจัดเก็บไฟล์ต้นทางไว้ที่ใด ชุดเครื่องมือพัฒนาจาวาเวอร์ชันอะไร ดัง
ตัวอย่างเป็นเวอร์ชัน 7 และลักษณะของการจัดวางโพรเจกต์ 

 หลังจากที่ท าการสร้างจาวาโพรเจกต์ ขั้นตอนต่อไปสามารถสร้างแพ็จเกจและคลาสต่างๆ 
เพ่ือรองรับการท างานในรูปแบบต่างๆ ตามท่ีต้องการ 
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ภาพที่ 30 การสร้างจาวาโพรเจกต์อีคลิปส์ 

  

 
ภาพที่ 31 การก าหนดชื่อของโพรเจกต์และรายละเอียดการสนับสนุนของอีคลิปส์ 
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4.3.3 การสร้างส่วนของท่ีเก็บข้อมูลน าเข้าและเอกซ์เอ็มไอ 

 การสร้างส่วนของการเก็บข้อมูลน าเข้าและเอกซ์เอ็มไอ ดังภาพที่ 32 เป็นส่วนที่เก็บข้อมูล
รายละเอียดของไฟล์น าเข้าและรายละเอียดข้อมูลของเอกซ์เอ็มไอ เพ่ือใช้ในการเก็บและแลกเปลี่ยน
ข้อมูลระหว่างกระบวนการ โดยแพ็คเกจของข้อมูลเก็บแยกเป็นคลาสตามลักษณะชนิดต่างๆ ซึ่งแต่ละ
คลาสจะมีหน้าที่ต่างกัน ดังต่อไปนี้ 

 ParseData ท าหน้าที่เก็บข้อมูลของตัวแจงส่วน (Parser) และแลกเปลี่ยนข้อมูล
ระหว่างกระบวนการสกัดองค์ประกอบและกระบวนการเทียบค่าเอกซ์เอ็มไอ 

 GenericDetailData ท าหน้าที่เก็บข้อมูลในกระบวนการแจงส่วนของฟอร์ม เมนู 
ไลบรารี และรายงาน 

 FormData ท าหน้าที่เก็บข้อมูลของฟอร์ม ใช้ในกระบวนการอ่านข้อมูลน าเข้า และ
กระบวนการสกัดองค์ประกอบของฟอร์ม 

 LibraryData ท าหน้าที่เก็บข้อมูลของไลบรารี ใช้ในกระบวนการอ่านข้อมูลน าเข้า 
และกระบวนการสกัดองค์ประกอบของไลบรารี 

 MenuData ท าหน้าที่เก็บข้อมูลของเมนู ใช้ในกระบวนการอ่านข้อมูลน าเข้า และ
กระบวนการสกัดองค์ประกอบของเมนู 

 ReportData ท าหน้าที่เก็บข้อมูลของรายงาน ใช้ในกระบวนการอ่านข้อมูลน าเข้า 
และกระบวนการสกัดองค์ประกอบของรายงาน 

 XMIForm ท าหน้าที่เก็บข้อมูลเอกซ์เอ็มไอของฟอร์ม ใช้ในกระบวนการเทียบค่า
เอกซ์เอ็มไอ 

 XMILibrary ท าหน้าที่เก็บข้อมูลเอกซ์เอ็มไอของไลบรารี ใช้ในกระบวนการเทียบค่า
เอกซ์เอ็มไอ 

 XMIMenu ท าหน้าที่เก็บข้อมูลเอกซ์เอ็มไอของเมนู ใช้ในกระบวนการเทียบค่าเอกซ์
เอ็มไอ 

 XMIReport ท าหน้าที่เก็บข้อมูลเอกซ์เอ็มไอของรายงาน ใช้ในกระบวนการเทียบค่า
เอกซ์เอ็มไอ 

 XMIOverAll ท าหน้าที่เก็บข้อมูลเอกซ์เอ็มไอของการแสดงความสัมพันธ์ภาพรวม ใช้
ในกระบวนการเทียบค่าเอกซ์เอ็มไอ  

การสร้างคลาสของจาวาโพรเจกต์มีรายละเอียดที่ส าคัญคือ การก าหนดชื่อคลาส การก าหนด
แพ็คเกจที่อยู่ของคลาส และการก าหนดคุณลักษณะของคลาส ดังภาพที่ 33 
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ภาพที่ 32 การสร้างแพ็คเกจเก็บข้อมูลน าเข้าและเอกซ์เอ็มไอ 

 
ภาพที่ 33 การสร้างคลาส ParseData ของแพ็คเกจเก็บข้อมูล 

4.3.4 การพัฒนาส่วนการสกัดองค์ประกอบของข้อมูลน าเข้า 

 การพัฒนาส่วนการสกัดองค์ประกอบข้อมูลน าเข้า เพ่ือให้ได้ข้อมูลน าเข้าที่จ าเป็นในการดึง
คอนเซปต์และหาความสัมพันธ์ของไฟล์น าเข้า โดยประกอบด้วย 
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4.3.4.1 ส่วนของการอ่านข้อมูลน าเข้า 

  ส่วนของการอ่านข้อมูลน าเข้า มีการสร้างแพ็คเกจ ดังภาพที่ 34 เนื่องจากการอ่าน
ข้อมูลน าเข้าแต่ละชนิดมีความแตกต่างกัน และมีอิลิเมนต์ที่จ าเป็น ดังตารางที 1 ต่างกัน โดยแพ็คเกจ
ของการอ่านข้อมูลจะเก็บคลาสแยกเป็นคลาสตามลักษณะชนิดต่างๆ ซึ่งแต่ละคลาสจะมีหน้าที่ต่างกัน 
ดังต่อไปนี้ 

 XmlFormReader ท าหน้าที่อ่านข้อมูลจากฟอร์ม และน าไปเก็บที่ FormData เพ่ือ
ใช้เป็นข้อมูลในกระบวนการต่อไป 

 XmlLibraryReader ท าหน้าที่อ่านข้อมูลจากไลบรารี และน าไปเก็บที่ LibraryData 
เพ่ือใช้เป็นข้อมูลในกระบวนการต่อไป 

 XmlMenuReader ท าหน้าที่อ่านข้อมูลจากเมนู และน าไปเก็บที่ MenuData เพ่ือ
ใช้เป็นข้อมูลในกระบวนการต่อไป 

 XmlReportReader ท าหน้าที่อ่านข้อมูลจากรายงาน และน าไปเก็บที่ ReportData 
เพ่ือใช้เป็นข้อมูลในกระบวนการต่อไป 

 

4.3.4.2 ส่วนของการแจงส่วน  

  ส่วนของการแจงส่วน จะเป็นคลาสการแจงส่วนอยู่ในแพ็คเกจกระบวนการหลัก ตาม
ภาพที่ 35 โดยคลาสแจงส่วนประกอบด้วยเมธอดต่างๆ ซึ่งมีหน้าที่แตกต่างกัน ดังต่อไปนี้ 

 ParsingForm ท าหน้าที่แจงส่วนของฟอร์ม โดยน าข้อมูลเข้าจาก XmlFormReader 
เพ่ือแจงส่วนฟอร์มให้อยู่ในรูปแบบตารางแฮช (Hash Table) ซึ่งมีคีย์ที่ส าคัญของ
ฟอร์มเพ่ือใช้ในกระบวนการต่อไป 

 ParsingLibrary ท า ห น้ า ที่ แ จ ง ส่ ว นข อ ง ไ ล บ ร า รี  โ ด ย น า ข้ อ มู ล เ ข้ า จ า ก 
XmlLibraryReader เพ่ือแจงส่วนฟอร์มให้อยู่ในรูปแบบตารางแฮช ซึ่งมีคีย์ที่ส าคัญ
ของฟอร์มเพ่ือใช้ในกระบวนการต่อไป 

 ParsingMenu ท าหน้าที่แจงส่วนของเมนู โดยน าข้อมูลเข้าจาก XmlMenuReader 
เพ่ือแจงส่วนฟอร์มให้อยู่ในรูปแบบตารางแฮช ซึ่งมีคีย์ที่ส าคัญของฟอร์มเพ่ือใช้ใน
กระบวนการต่อไป 

 ParsingReport ท า ห น้ า ที่ แ จ ง ส่ ว นข อ ง ร า ย ง า น  โ ดย น า ข้ อ มู ล เ ข้ า จ า ก 
XmlReportReader เพ่ือแจงส่วนฟอร์มให้อยู่ในรูปแบบตารางแฮช ซึ่งมีคีย์ที่ส าคัญ
ของฟอร์มเพ่ือใช้ในกระบวนการต่อไป 
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ภาพที่ 34 การสร้างแพ็คเกจการอ่านข้อมูลน าเข้า 

 
ภาพที่ 35 การสร้างแพ็คเกจกระบวนการหลัก 

4.3.5 การพัฒนาส่วนของการเทียบค่าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ 

 การพัฒนาส่วนของการเทียบค่าให้อยู่ในรูปแบบเอกสารเอกซ์เอ็มไอ ชนิดแบบจ าลองไม่
ขึ้นกับแพลตฟอร์ม เพ่ือให้ได้เมตาโมเดลเอกซ์เอ็มไอ จะอยู่ในแพ็คเกจกระบวนการเอกซ์เอ็มไอ ดัง
ภาพที ่36 ประกอบด้วย 
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ภาพที่ 36 การสร้างแพ็คเกจกระบวนการเอกซ์เอ็มไอ 

4.3.5.1 ส่วนของการตรวจสอบความสัมพันธ์ 

  ส่วนการตรวจสอบความสัมพันธ์ของไฟล์น าเข้า เป็นคลาสอยู่ ในแพ็คเกจ
กระบวนการเอกซ์เอ็มไอ เพ่ือตรวจสอบหาความสัมพันธ์ของไฟล์น าเข้า เทียบกับเมตาโมเดลของพี
แอลเอสคิวแอล โดยในคลาสการตรวจสอบความสัมพันธ์ มีเมธอด ที่ท าหน้าที่ต่างกัน ดังต่อไปนี้ 

 FormValidation ท าหน้าที่ตรวจสอบความสัมพันธ์ของฟอร์ม ว่าในแต่ละส่วนของ
แอททริบิวต์มีความสัมพันธ์กับส่วนไหนบ้าง ส่วนหลัก (Main) ของฟอร์มโดยโค้ด 
ตามภาพที่ 37 ข้อมูลน าเข้าได้จากตารางแฮชของฟอร์มซึ่งมีคีย์ส าคัญในการ
ตรวจสอบ หลังจากนั้นจะน าข้อมูลเพ่ือใช้ในกระบวนการเทียบค่าและสร้างรายงาน
ต่อไป 

 MenuValidation ท าหน้าที่ตรวจสอบความสัมพันธ์ของเมนู ว่าในแต่ละส่วนของแอ
ททริบิวต์มีความสัมพันธ์กับส่วนไหนบ้าง ข้อมูลน าเข้าได้จากตารางแฮชของเมนูซึ่งมี
คีย์ส าคัญในการตรวจสอบ หลังจากนั้นจะน าข้อมูลเพ่ือใช้ในกระบวนการเทียบค่า
และสร้างรายงานต่อไป 

 LibraryValidation ท าหน้าที่ตรวจสอบความสัมพันธ์ของไลบรารี ว่าในแต่ละส่วน
ของแอททริบิวต์มีความสัมพันธ์กับส่วนไหนบ้าง ข้อมูลน าเข้าได้จากตารางแฮชของ
ไลบรารีซึ่ งมีคีย์ส าคัญในการตรวจสอบ  หลังจากนั้นจะน าข้อมูลเ พ่ือใช้ ใน
กระบวนการเทียบค่าและสร้างรายงานต่อไป 

 ReportValidation ท าหน้าที่ตรวจสอบความสัมพันธ์ของรายงาน ว่าในแต่ละส่วน
ของแอททริบิวต์มีความสัมพันธ์กับส่วนไหนบ้าง ข้อมูลน าเข้าได้จากตารางแฮชของ
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รายงานซึ่ งมีคีย์ส าคัญในการตรวจสอบ หลังจากนั้นจะน าข้อมูลเ พ่ือใช้ ใน
กระบวนการเทียบค่าและสร้างรายงานต่อไป 

 OverAllValidation ท าหน้าที่ตรวจสอบความสัมพันธ์ของไฟล์น าเข้าทั้งหมด ว่าใน
แต่ละไฟล์นั้นมีความสัมพันธ์กันอย่างไร มีความสัมพันธ์ที่ขาดหายหรือไม่ ข้อมูล
น าเข้าได้จากตารางแฮชของทุกไฟล์ซึ่งมีคีย์ส าคัญในการตรวจสอบ หลังจากนั้นจะ
น าข้อมูลเพื่อใช้ในกระบวนการเทียบค่าและสร้างรายงานต่อไป 

 

/** Main Form validation**/ 
 StringBuilder relaMenu = new StringBuilder(); 
 xmiForm.setName(tmpFmb.getName().trim()); 
 if("F".equals(Type.trim())){xmiForm.setType("Form");} 
 xmiForm.setCardinality(1); 
 xmiForm.setPriorityType(49); 
 if(Attl>0){countRelation++;relaMenu.append("AttachedLibrary");} 
 if(Blc>0){countRelation++;relaMenu.append("Block");} 
 if(Proc>0||Func>0){countRelation++;relaMenu.append("ProgramUnit");} 
 if(Lov>0){countRelation++;relaMenu.append("LOV");} 
 if(Rgr>0){countRelation++;relaMenu.append("RecordGroup");} 
 if(Trig>0){countRelation++;relaMenu.append("Trigger");} 

xmiForm.setRelation(countRelation);xmiForm.setRelationWith(relaMenu.
toString().trim().replaceAll("\\s", ",")); 
 String fmbID = XOG.XMICheck(xmiID,xmiFormat); 
 xmiID.add(fmbID); 
 xmiForm.setXmiID(fmbID); 
 xmiForm.setXmiFormat(xmiFormat); 
 outputXMI.add(xmiForm); 

 
ภาพที่ 37 โค้ดส่วนการตรวจสอบความสัมพันธ์ของฟอร์มในส่วนหลัก 

4.3.5.2 ส่วนของการเทียบค่าให้อยู่ในรูปแบบเอกซ์เอ็มไอ 

  ส่วนของการเทียบค่าให้อยู่ในรูปแบบเอกซ์เอ็มไอ เป็นคลาสอยู่ในอยู่ในแพ็คเกจ
กระบวนการเอกซ์เอ็มไอ เพ่ือเทียบค่าที่ได้จากการตรวจสอบหาความสัมพันธ์ให้อยู่ในรูปแบบเมตา
โมเดลเอกซ์เอ็มไอ ชนิดแบบจ าลองไม่ขึ้นกับแพลตฟอร์ม โดยในคลาสประกอบด้วยเมธอด ที่มีหน้าที่
แตกต่างกัน ดังต่อไปนี้ 

 XMICheckID ท าหน้าที่สร้างไอดีให้กับแอททริบิวต์ทุกตัวของเอกซ์เอ็มไอ 
เพ่ือใช้ในการหาความสัมพันธ์กันระหว่างแอททริบิวต์ภายในเอกซ์เอ็มไอ 

 XMIFormGenerate ท าหน้าที่เทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็มไอ
ของฟอร์ม โดยโค้ด ดังภาพที่ 38 ข้อมูลน าเข้าได้จากกระบวนการตรวจสอบ
ความสัมพันธ์ในรูปแบบอาร์เรย์ลิสต์และตารางแฮชของฟอร์ม 

 XMIMenuGenerate ท าหน้าที่เทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็มไอ
ของเมนู ข้อมูลน าเข้าได้จากกระบวนการตรวจสอบความสัมพันธ์ในรูปแบบ
อาร์เรย์ลิสต์และตารางแฮชของเมนู 
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 XMILibraryGenerate ท าหน้าที่เทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็ม
ไอของไลบรารี ข้อมูลน าเข้าได้จากกระบวนการตรวจสอบความสัมพันธ์ใน
รูปแบบอาร์เรย์ลิสต์และตารางแฮชของไลบรารี 

 XMIReportGenerate ท าหน้าที่เทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็ม
ไอของรายงาน ข้อมูลน าเข้าได้จากกระบวนการตรวจสอบความสัมพันธ์ใน
รูปแบบอาร์เรย์ลิสต์และตารางแฮชของรายงาน 

 XMIOverallGenerate ท าหน้าที่เทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็ม
ไอของภาพรวมระบบหรือไฟล์น าเข้าทั้ งหมด  ข้อมูลน าเข้าได้จาก
กระบวนการตรวจสอบความสัมพันธ์ในรูปแบบอาร์เรย์ลิสต์และตารางแฮช
ของภาพรวมระบบ 

 

/** Check Relationships**/ 
 if(ArrXP.get(i).getRelation()>0){ 
 String RelaWith[] = ArrXP.get(i).getRelationWith().split(","); 
 for (String s : RelaWith){ 
/** Check Relawith Not null **/  

if(!s.trim().equals("")){ 
/**Check RelationWith **/ 
 for (int j = 0; j < ArrXP.size(); j++){ 

XMIForm auc = ArrXP.get(j); 
/** RelationWith & Name**/ 
 if (s.trim().equals(auc.getName().trim())){ 
/**Name & RelationWith**/           
if(ArrXP.get(j).getRelationWith().indexOf(ArrXP.get(i).getName().trim())!=-1){ 
/**Priority Type**/            
if(ArrXP.get(i).getPriorityType()>ArrXP.get(j).getPriorityType()){ 
/**Generalize ProgramUnit vs Procedure&Function**/            
if(("Procedure".equals(ArrXP.get(i).getName().trim())||"Function".equals(ArrXP.get(
i).getName().trim()))&&"ProgramUnit".equals(ArrXP.get(j).getName().trim())){ 
String generalID =  XMICheck(xmiID,xmiFormat);  

xmiID.add(generalID); 
 Element general = doc.createElement("generalization");       
 packagedElement.appendChild(general); 

attr = doc.createAttribute("xmi:type");          
 attr.setValue("uml:Generalization");          
 general.setAttributeNode(attr); 

attr = doc.createAttribute("xmi:id"); 
 attr.setValue(generalID);           
 general.setAttributeNode(attr); 

attr = doc.createAttribute("general");          
 attr.setValue(ArrXP.get(j).getXmiID());          
 general.setAttributeNode(attr); 
}else {     
/**Inside Attribute**/ 

String attrID = XMICheck(xmiID,xmiFormat); 
 xmiID.add(attrID); 
 String assoID = XMICheck(xmiID,xmiFormat); 
 xmiID.add(assoID); 
 Element ownAttr = doc.createElement("ownedAttribute");       
 packagedElement.appendChild(ownAttr); 
 attr = doc.createAttribute("xmi:type");          
 attr.setValue("uml:Property"); 
 ownAttr.setAttributeNode(attr); 
 attr = doc.createAttribute("type"); 

attr.setValue(ArrXP.get(j).getXmiID()); 
 ownAttr.setAttributeNode(attr); 
 attr = doc.createAttribute("xmi:id");          
 attr.setValue(attrID);           
 ownAttr.setAttributeNode(attr); 

attr = doc.createAttribute("isUnique")          
 attr.setValue("false");      
 ownAttr.setAttributeNode(attr); 

if(("Form".equals(ArrXP.get(i).getType().trim())||"Library".equals(ArrXP.ge
t(i).getType().trim())||"Menu".equals(ArrXP.get(i).getType().trim())||"Report".equa
ls(ArrXP.get(i).getType().trim()))&&"Trigger".equals(ArrXP.get(j).getName().trim())
){ 

attr = doc.createAttribute("aggregation"); 
 attr.setValue("composite"); 

ownAttr.setAttributeNode(attr); 
}else 
if("Block".equals(ArrXP.get(i).getName().trim())&&"Relation".equals(ArrXP.get(j).ge
tName().trim())){ 

attr = doc.createAttribute("aggregation");         
 attr.setValue("composite");         
 ownAttr.setAttributeNode(attr); 

 
ภาพที่ 38 โค้ดส่วนการเทียบค่าความสัมพันธ์และสร้างเอกซ์เอ็มไอของฟอร์ม 

4.3.6 การพัฒนาส่วนของการสร้างรายงานข้อมูลสถิติ 

 การพัฒนาส่วนของการสร้างรายงานข้อมูลสถิติ เริ่มต้นเราจะต้องติดตั้งปลั๊กอินพีโอไอซึ่งเป็น
ปลั๊กอินในการสร้างรายงานรูปแบบเอกซ์เซล สามารถดาวน์โหลดได้จาก http://poi.apache.org/ 
เป็นฟรีปลั๊กอิน  
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 หลังจากดาวน์โหลดปลั๊กอินพีโอไอแล้ว ท าการติดตั้งโดยการคลิกขวาที่จาวาโพรเจกต์ เลือก 
Java Build Path และท าการเลือก Add External JARs เพ่ือท าการเลือกปลั๊กอินพีโอไอ เมื่อติดตั้ง
เสร็จคลิกปุ่มโอเค ดังภาพที่ 39 

 
ภาพที่ 39 การติดตั้งปลั๊กอินพีโอไอรายงาน 

 เมื่อท าการติดตั้งปลั๊กอินพีโอไอแล้ว ขั้นตอนต่อไปสร้างแพ็คเกจรายงาน ดังภาพที่ 40  

 
ภาพที่ 40 การสร้างแพ็คเกจรายงานข้อมูลสถิติ 

4.3.7 การส่งออกระบบท่ีพัฒนา 

 การส่งออกระบบที่พัฒนา  จะอยู่ในรูปแบบจาร์ไฟล์ ซึ่งในจาร์ไฟล์ประกอบด้วยแพ็คเกจ
ต่างๆ ที่มีลักษณะหน้าที่เฉพาะตัวต่างกัน เพ่ือความสะดวกในการเรียกใช้งานของผู้ที่น าระบบไปติดตั้ง
โดยขั้นตอนของการส่งออกระบบนั้น เริ่มจากคลิกขวาที่จาวาโพรเจกต์เลือกส่งออก (Export) จากนั้น
ท าการคลิกเลือกส่งออกจาร์ไฟล์ ดังภาพที่ 41 
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ภาพที่ 41 การเลือกส่งออกจาร์ไฟล์ 

 
ภาพที่ 42 การก าหนดรายละเอียดการส่งออกจาร์ไฟล์ 

 หลังจากนั้นก าหนดรายละเอียดของการส่งออกจาร์ไฟล์คือ เลือกซอสโฟลเดอร์ที่ต้องการจะ
ส่งออก โดยมีลักษณะการส่งออกให้เลือกตามต้องการ  ก าหนดพาธ (path) ในการส่งออกจาร์ไฟล์ 
และส่วนเสริมส าคัญคือเลือกการบีบอัดเนื้อให้อยู่ในรูปแบบจาร์ไฟล์ ดังภาพที่ 42 ต่อมาการก าหนด
คุณสมบัติเสริมในการตรวจสอบความถูกต้องของแพ็คเกจ ดังภาพที่ 43 
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ภาพที่ 43 การก าหนดคุณสมบัติเสริมตรวจสอบแพ็คเกจ 

 
ภาพที่ 44 อีคลิปส์แสดงรายละเอียดแพ็คเกจที่คอมไพล์ 

 เมื่อท าการคลิกเสร็จสิ้น อีคลิปส์จะท าการคอมไพล์ตรวจสอบแพ็คเกจเพ่ือความถูกต้องและ
แสดงรายละเอียดข้อมูลที่คอมไพล์ ดังภาพที่ 44 หลังจากนั้นจะได้ไฟล์ระบบที่พัฒนาอยู่ในรูปแบบ
จาร์ไฟล์ตามพาธที่เราได้ก าหนดไว้ จาร์ไฟล์ระบบที่ได้สามารถน าไปประยุกต์ใช้ในซอฟต์แวร์อ่ืนๆ ที่
รองรับภาษาจาวา และนักพัฒนาอ่ืนสามารถน าจาร์ไฟล์ไปติดตั้งพัฒนา เพ่ือเพ่ิมประสิทธิภาพของ
ซอฟต์แวร์ให้ดียิ่งขึ้น  โดยวิธีการติดตั้งตามภาคผนวก ก.



บทที ่5  
การประเมินและการวัดผล 

5.1 แนวทางการประเมินผลงานวิจัย 

แนวทางการประเมินใช้วิธีการประเมินจาก การประเมินของผู้เชี่ยวชาญ (นักวิเคราะห์ระบบ
หรือนักพัฒนาระบบ) และรวมถึงผลลัพธ์ที่ได้จากซอฟต์แวร์ของระบบ เนื่องจากงานวิจัยเป็นการดึง
คอนเซปต์ของการออกแบบระบบเดิมเพ่ือแสดงให้เห็นในรูปแบบแผนภาพคลาสและรายงานทางสถิติ 
โดยส าหรับการเลือกข้อมูลน าเข้าตัวอย่างของระบบเก่านั้น จะใช้เกณฑ์ในการคัดเลือกระบบเก่า
สอดคล้องและครอบคลุมกับแนวตาม [10] โดยแนวทางการประเมินประกอบด้วยรายละเอียดต่างๆ 
ดังต่อไปนี้ 

1. ข้อมูลน าเข้าจาก Oracle Developer Tools 

2. ผลลัพธ์เอกสารเอกซ์เอ็มไอของระบบ 

3. ผลลัพธ์แสดงแผนภาพคลาสของโมเดลลิโอ 

4. ผลลัพธ์รายงานสถิติของระบบ 

5. ข้อสังเกต 

ส าหรับการวัดผลนั้นจะดูจากแผนภาพคลาสและรายงานสถิติ เพ่ือบอกรายละเอียดของการ
ดึงคอนเซปต์ ว่าการแสดงความสัมพันธ์ของข้อมูลน าเข้านั้นถูกต้อง โดยมีนักเคราะห์ระบบหรือ
นักพัฒนาระบบ ท าความเข้าใจกับคอนเซปต์ที่ดึงออกมา 

5.2 การประเมินผลระบบ 

5.2.1 ข้อมูลน าเข้าจาก Oracle Developer Tools 

 ตัวอย่างข้อมูลน าเข้าจากซอฟต์แวร์ Oracle Developer Tools  ซึ่งประกอบด้วยข้อมูล 
ฟอร์ม (.fmb),เมนู (.mmb), รายงาน (.rdf) และ ไลบรารี (.pll)   เป็นข้อมูลที่ส่งออกมาจากซอฟต์แวร์ 
หลังจากนั้น มาผ่านกระบวนการฟังก์ชันเสริม Form2XML  เพ่ือได้ข้อมูลน าเข้าที่สมบูรณ์ส าหรับ
น าเข้าระบบในรูปแบบเอกสารเอกซ์เอ็มแอลและพีแอลดี ซอฟต์แวร์ รายละเอียดการส่งออกและรหัส
ต้นทางตัวอย่างตามภาคผนวก ค 

 ตัวอย่างข้อมูลน าเข้าคัดเลือกตัวอย่างบางส่วนจากระบบบัญชีเคาน์เตอร์เซอร์วิส 7-11 มี
ดังต่อไปนี้ 

- CSMENU_MMB.mmb เมนูของระบบบัญชี 

- GBLM0110_FMB.fmb ฟอร์มบันทึกข้อมูลผู้ว่าจ้าง 

- GBLM0103_FMB.fmb ฟอร์มบันทึกข้อมูลร้านสาขา 

- GBLM0120_FMB.fmb ฟอร์มบันทึกข้อมูลสาขาของผู้ว่าจ้าง 
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- SLTR0080_FMB.fmb ฟอร์มรายงานสรุปการจัดท า statement 

- RECR0080_RDF.rdf รายงานสรุปการจัดท า statement 

- SLTR0020_FMB.fmb ฟอร์มรายงานผลการจัดท า statement 

- SLTR0020_RDF.rdf รายงานการจัดท า statement 

- MPL_CS_PLL.pld ไลบรารีของระบบบัญชี 

- MPL_0002_PLL.pld ไลบรารีของระบบบัญชี 

 

5.2.2 ผลลัพธ์เอกสารเอกซ์เอ็มไอของระบบ 

 ผลลัพธ์ที่ได้จากระบบคือเอกสารเอกซ์เอ็มไอ ชนิดแบบจ าลองไม่ขึ้นกับแพลตฟอร์ม รองรับ
การท างานของโมเดลลิโอ3.0.0 รหัสต้นทางผลลัพธ์เอกสารเอกซ์เอ็มไอ ตามภาคผนวก ง ซึ่ง
ประกอบด้วย 

- XMIOverAll.xmi  เอกซ์เอ็มไอภาพรวมความสัมพันธ์ของระบบ 

- XMIMenu_CSMENU.xmi เอกซ์เอ็มไอแสดงรายละเอียดของเมนู 

- XMIForm_GBLM0110.xmi เอกซ์เอ็มไอแสดงรายละเอียดของฟอร์ม 

- XMIForm_GBLM0103.xmi เอกซ์เอ็มไอแสดงรายละเอียดของฟอร์ม 

- XMIForm_GBLM0120.xmi เอกซ์เอ็มไอแสดงรายละเอียดของฟอร์ม 

- XMIForm_SLTR0080.xmi เอกซ์เอ็มไอแสดงรายละเอียดของฟอร์ม 

- XMIForm_SLTR0020.xmi เอกซ์เอ็มไอแสดงรายละเอียดของฟอร์ม 

- XMIReport_RECR0080.xmi เอกซ์เอ็มไอแสดงรายละเอียดของรายงาน 

- XMIReport_SLTR0020.xmi เอกซ์เอ็มไอแสดงรายละเอียดของรายงาน 

- XMILibrary_MPL_CS.xmi เอกซ์เอ็มไอแสดงรายละเอียดของไลบรารี 

- XMILibrary_MPL_0002.xmi เอกซ์เอ็มไอแสดงรายละเอียดของไลบรารี 

5.2.3 ผลลัพธ์แสดงแผนภาพคลาสของโมเดลลิโอ (Modelio) 

 ผลลัพธ์เอกสารเอกซ์เอ็มไอที่ได้จากระบบ จะใช้เป็นข้อมูลน าเข้าของซอฟต์แวร์โมเดลลิโอ 
3.0.0 เพ่ือใช้แสดงแผนภาพคลาสภาพรวมความสัมพันธ์ของระบบ และส่วนย่อยชนิดต่างๆของระบบ 
ได้ดังนี ้
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- แผนภาพคลาสที่ได้จาก XMIOverAll.xmi  ดังภาพที่ 45 

 
ภาพที่ 45 แผนภาพคลาสแสดงความสัมธันธ์ของภาพรวมระบบ 

- แผนภาพคลาสที่ได้จาก XMIMenu_CSMENU.xmi ดังภาพที่ 46 

 
ภาพที่ 46 แผนภาพคลาสของเมนู CSMENU 
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- แผนภาพคลาสที่ได้จาก XMIForm_GBLM0110.xmi ดังภาพที่ 47 

 
ภาพที่ 47 แผนภาพคลาสของฟอร์ม GBLM0110 

- แผนภาพคลาสที่ได้จาก XMIForm_GBLM0103.xmi ดังภาพที่ 48 

 
ภาพที ่48 แผนภาพคลาสของฟอร์ม GBLM0103 
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- แผนภาพคลาสที่ได้จาก XMIForm_GBLM0120.xmi ดังภาพที่ 49 

 
ภาพที่ 49 แผนภาพคลาสของฟอร์ม GBLM0120 

- แผนภาพคลาสที่ได้จาก XMIForm_SLTR0080.xmi ดังภาพที่ 50 

 
ภาพที่ 50 แผนภาพคลาสของฟอร์ม SLTR0080 
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- แผนภาพคลาสที่ได้จาก XMIForm_SLTR0020.xmi ดังภาพที่ 51 

 
ภาพที่ 51 แผนภาพคลาสของฟอร์ม SLTR0020 

- แผนภาพคลาสที่ได้จาก XMIReport_RECR0080.xmi ดังภาพที่ 52 

 
ภาพที่ 52 แผนภาพคลาสของรายงาน RECR0080 
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- แผนภาพคลาสที่ได้จาก XMIReport_SLTR0020.xmi ดังภาพที่ 53 

 
ภาพที่ 53 แผนภาพคลาสของรายงาน SLTR0020 

- แผนภาพคลาสที่ได้จาก XMILibrary_MPL_CS.xmi ดังภาพที่ 54 

 
ภาพที่ 54 แผนภาพคลาสของไลบรารี MPL_CS 

- แผนภาพคลาสที่ได้จาก XMILibrary_MPL_0002.xmi ดังภาพที่ 55 

 
ภาพที่ 55 แผนภาพคลาสของไลบรารี MPL_0002 
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5.2.4 ผลลัพธ์รายงานสถิติของระบบ 

 ผลลัพธ์ที่ได้จากระบบคือรายงานสถิติ ซึ่งรวบรวมข้อมูลของการดึงคอนเซปต์ขับเคลื่อนด้วย
แบบจ าลองจากชุดค าสั่งเชิงกระบวนงานของซอฟต์แวร์ Oracle Developer Tools โดยรายงาน
แสดงข้อมูลภาพรวมความสัมพันธ์ของระบบและรายละเอียดของระบบชนิดต่างๆ รายงานแสดงใน
รูปแบบเอกสารเอกซ์เซล แสดงแถบของรายงาน ตามภาพท่ี 56 

 
ภาพที่ 56 แถบข้อมูลรายงานของเอกสารเอกซ์เซล 

 จากผังงานที่ 5.2.3 แสดงแผนภาพคลาสของผลลัพธ์เอกซ์เอ็มไอทั้งภาพรวมและรายละเอียด
ของระบบมีรายละเอียดรายงานในแต่ละส่วน ดังต่อไปนี้ 

- ภาพรวมระบบแถบ Statistical Data Overall มีรายละเอียด ตามภาพที่ 
57 

 
ภาพที่ 57 หน้าแถบรายงานสถิติของภาพรวมระบบ 

 การดูรายงานสถิติสามารถคลิกหมายเลข 1 เพ่ือซ่อนข้อมูลในกรณีที่มีข้อมูลเป็นจ านวนมาก 
หรือ 2 เพ่ือแสดงข้อมูลทั้งหมด และในช่องข้อมูล สามารถดับเบิ้ลคลิกเพ่ือดูข้อมูลครบทั้งหมด 
รายละเอียดหน้าที่ของแต่ละฟิลด์ตามผังงาน 3.5 และจากภาพที่ 45 แผนภาพคลาสภาพรวมของ
ระบบ ของผังงาน 5.2.3 จะมีความสอดคล้องกับรายงานสถิติเช่น จ านวนความสัมพันธ์ของแต่ละส่วน 
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- รายละเอียดของฟอร์มแถบ GBLM0103 ตามภาพที่ 58 

 
ภาพที่ 58 หน้าแถบรายงานสถิติของฟอร์ม GBLM0103 

 รายงานสถิติแถบฟอร์ม GBLM0130 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของฟอร์ม โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 48  
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- รายละเอียดของฟอร์มแถบ GBLM0110 ตามภาพที่ 59 

 
ภาพที่ 59 หน้าแถบรายงานสถิติของฟอร์ม GBLM0110 

 รายงานสถิติแถบฟอร์ม GBLM0110 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของฟอร์ม โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 47  

 

 

 

 

 

 

 

 

 



 48 

- รายละเอียดของฟอร์มแถบ GBLM0120 ตามภาพที่ 60 

 
ภาพที่ 60 หน้าแถบรายงานสถิติของฟอร์ม GBLM0120 

รายงานสถิติแถบฟอร์ม GBLM0120 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของฟอร์ม โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 49 
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- รายละเอียดของฟอร์มแถบ SLTR0020 ตามภาพท่ี 61 

 
ภาพที่ 61 หน้าแถบรายงานสถิติของฟอร์ม SLTR0020 

รายงานสถิติแถบฟอร์ม SLTR0020 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของฟอร์ม โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 51 
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- รายละเอียดของฟอร์มแถบ SLTR0080 ตามภาพท่ี 62 

 
ภาพที่ 62 หน้าแถบรายงานสถิติของฟอร์ม SLTR0080 

รายงานสถิติแถบฟอร์ม SLTR0080 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของฟอร์ม โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 50 

 

 

 

 

 

 

 

 

 



 51 

- รายละเอียดของรายงานแถบ RECR0080 ตามภาพท่ี 63 

 
ภาพที่ 63 หน้าแถบรายงานสถิติของรายงาน RECR0080 

รายงานสถิติแถบรายงาน RECR0080 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของ
แต่ละส่วนประกอบของรายงาน โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 52 
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- รายละเอียดของรายงานแถบ SLTR0020_1 ตามภาพที่ 64 

 
ภาพที่ 64 หน้าแถบรายงานสถิติของรายงาน SLTR0020_1 

รายงานสถิติแถบรายงาน SLTR0020_1 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของ
แต่ละส่วนประกอบของรายงาน โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 53 
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- รายละเอียดของเมนูแถบ CSMENU ตามภาพท่ี 65 

 
ภาพที่ 65 หน้าแถบรายงานสถิติของเมนู CSMENU 

รายงานสถิติแถบเมนู CSMENU แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่ละ
ส่วนประกอบของเมนู โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 46 
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- รายละเอียดของไลบรารีแถบ MPL_CS ตามภาพที่ 66 

 
ภาพที่ 66 หน้าแถบรายงานสถิติของไลบรารี MPL_CS 

รายงานสถิติแถบไลบรารี MPL_CS แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของแต่
ละส่วนประกอบของไลบรารี โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 54 
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- รายละเอียดของไลบรารีแถบ MPL_0002 ตามภาพที่ 67 

 
ภาพที่ 67 หน้าแถบรายงานสถิติของไลบรารี MPL_0002 

รายงานสถิติแถบไลบรารี MPL_0002 แสดงรายละเอียดข้อมูลจ านวนและรายละเอียดของ
แต่ละส่วนประกอบของไลบรารี โดยสามารถดูควบคู่กับแผนภาพคลาส ตามภาพท่ี 55 

5.2.5 ข้อสังเกต 

 ผลลัพธ์ที่ได้จากระบบคือเอกสารเอ็มซ์เอ็มไอ ซึ่งสามารถเป็นข้อมูลน าเข้าส าหรับซอฟต์แวร์
อ่ืนๆ ที่รองรับมาตรฐาน ในงานวิจัยนี้รองรับซอฟต์แวร์โมเดลลิโอ 3.0.0  และรายงานสถิติของการดึง
คอนเซปต์ ซึ่งรายละเอียดของรายงานหน้าหลักคือแถบ Statistical Data Overall หรือตามภาพที่ 
57 สามารถบอกภาพรวมจ านวนความสัมพันธ์  รายละเอียดความสัมพันธ์ในแถบหัวเรื่อง 
PROCEDURES RELATION ,FUNCTIONS RELATION และ OTHERS RELATION แถบ MISSING 
เป็นการบอกถึงสิ่งที่ขาดหายไปในระบบ ที่ไม่ได้น าเข้ามาด้วย และส่วน INVALID RELATIONSHIP 
เป็นส่วนที่ตรวจสอบความสัมพันธ์ระหว่างข้อมูลน าเข้า ทั้งนี้ผลลัพธ์ที่ได้จากระบบนั้นสามารถดูควบคู่
กันเพ่ือท าความเข้าใจ ได้โดยนักวิเคราะห์หรือนักพัฒนาระบบ และตัวรายงานสามารถบอกสิ่งที่
ผิดพลาดหรือขาดหาย ได้อย่างถูกต้อง



บทที ่6  
สรุปผลการวิจัย และข้อเสนอแนะ 

6.1 สรุปผลการวิจัย 

งานวิจัยนี้ได้น าเสนอการดึงคอนเซปต์ขับเคลื่อนด้วยแบบจ าลองจากชุดค าสั่งเชิงกระบวนงาน 
เพ่ือช่วยท าความเข้าใจในการออกแบบระบบเดิมที่พัฒนาด้วยภาษาพีแอลเอสคิวแอล ส าหรับการรื้อ
ปรับระบบให้เป็นระบบใหม่เพ่ือตอบสนองความต้องการทางธุรกิจขององค์กรและรองรับเทคโนโลยีใน
ปัจจุบัน ซึ่งเครื่องมือจะได้ผลลัพธ์เป็นรายงานสถิติของการดึงคอนเซปต์ และเอกสารเอกซ์เอ็มไอ ที่
สามารถน าเข้าสู่ซอฟต์แวร์โมเดลลิโอ เพ่ือให้ได้ผลลัพธ์ที่แสดงแผนภาพคลาส 

ซึ่งจากการทดลองใช้งานเครื่องมือการดึงคอนเซปต์ในบทที่ 5 แสดงให้เห็นว่าเครื่องมือ
สามารถดึงคอนเซปต์ขับเคลื่อนด้วยแบบจ าลองจากชุดค าสั่งเชิงกระบวนงานของซอฟต์แวร์ Oracle 
Developer Tools ออกเป็นรายงานสถิติที่แสดงรายละเอียดภาพรวมของระบบและตรวจสอบ
ความสัมพันธ์ที่ผิดพลาดหรือขาดหายได้ถูกต้อง รวมถึงได้ผลลัพธ์เป็นเอกสารเอกซ์เอ็มไอ  ชนิด
แบบจ าลองไม่ขึ้นกับแพลตฟอร์ม ซึ่งงานวิจัยนี้เอกซ์เอ็มไอรองรับซอฟต์แวร์โมเดลลิโอ 3.0.0 เพ่ือใช้
แสดงแผนภาพคลาสภาพรวมและรายละเอียดย่อยของระบบ ได้อย่างถูกต้อง 

6.2 ข้อจ ากัด 

1. ไม่รองรับข้อมูลน าเข้า  Form (.fmb), Report (.rdf), Library (.pll), Menu (.mmb) 
ของ Oracle Developer Tool Version 6g , 11g 

2. เอกซ์เอ็มไอผลลัพธ์รองรับตามข้อก าหนดยูเอ็มแอลเวอร์ชัน 2.4.1 เพ่ือแสดงแผนภาพ
คลาสผ่านโมเดลลิโอ เวอร์ชัน 3.0.0 เท่านั้น 

6.3 แนวการวิจัยต่อ 

 เครื่องมือการดึงคอนเซปต์ไม่สามารถรองรับข้อมูลน าเข้าจาก Oracle Developer Tool 
ในบางเวอร์ชัน ดังนั้นเพ่ือการรองรับกับเทคโนโลยีใหม่ๆ จะต้องสามารถรองรับข้อมูล
น าเข้าได้ทุกเวอร์ชัน 

 การแสดงภาพคลาสของเอกซ์เอ็มไอผลลัพธ์นั้นยังรอบรับซอฟต์แวร์ได้เพียง 1 ซอฟต์แวร์
เท่านั้น ยังมีซอฟต์แวร์ในการออกแบบแผนภาพคลาสอีกมาก ดังนั้นการปรับปรุงส่วน
ของเอกซ์เอ็มไอผลลัพธ์เพ่ือให้รอบรับกับทุกซอฟต์แวร์ จะท าให้การแสดงแผนภาพมี
ประสิทธิภาพและน่าสนใจมากยิ่งข้ึน 

 เอกซ์เอ็มไอผลลัพธ์เป็นเมตาโมเดลที่ได้จากการดึงคอนเซปต์ขับเคลื่อนด้วยแบบจ าลอง 
ซึ่งปัจจุบัน มีซอฟต์แวร์ที่สามารถสร้างโค้ดที่ได้จากโมเดลเป็นจ านวนมาก ดังนั้น การ
ปรับปรุงเอกซ์เอ็มไอผลลัพธ์ให้สามารถรองรับซอฟต์แวร์สร้างโค้ด จะท าให้ลดระยะเวลา
ในการเข้าใจในแผนภาพคลาส เพ่ือน ามาเขียนโปรแกร
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ภาคผนวก 
 



ภาคผนวก ก  
การติดตั้งจาร์ไฟล์ผลลัพธ์เพื่อใช้งาน 

  

 การติดตั้งจาร์ไฟล์ผลลัพธ์เ พ่ือใช้งานของนักพัฒนาซอฟต์แวร์หรือผู้ที่ต้องการใช้งาน
ซอฟต์แวร์การดึงคอนเซปต์จากชุดค าสั่งเชิงกระบวนการ รอบรับซอฟต์แวร์ที่พัฒนาด้วยภาษาจาวา 
โดยงานวิจัยนี้ใช้อีคลิปส์ เวอร์ชันเคปเลอร์ 4.3.2 ในการพัฒนา การติดตั้งจาร์ไฟล์มีล าดับขั้นตอน
ดังต่อไปนี้ 

1. เตรียมเครื่องมือส าหรับพัฒนาซอฟต์แวร์รองรับภาษาจาวา ในการทดสอบเพ่ือใช้งานระบบนี้
จะใช้เครื่องมืออีคลิปส์ ที่รองรับภาษาจาวา ดังภาพที่ 68 

 
ภาพที่ 68 เครื่องมืออีคลิปส์ เวอร์ชันเคปเลอร์ 

2. สร้าง Workspace และตั้งชื่อ หลังจากนั้นเข้าสู่หน้าจอหลัก คลิกแถบเมนู File > New > 
Others เลือก Java Project ดังภาพที่ 69 จะปรากฎหน้าจอตามภาพท่ี 70 

 
ภาพที่ 69 การสร้างโพรเจกต์จาวา 
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3. ระบุชื่อโพรเจกต์ และตั้งค่าต่างๆ ตามภาพท่ี 70 

 
ภาพที่ 70 การตั้งค่าโพรเจกต์จาวา 

4. คลิกขวาที่ โพรเจกต์  เลือก Properties >   Java Build Path > Libraries เลือก Add 
External Jars เลือกจาร์ไฟล์ผลลัพธ์ที่ต้องการใช้งาน ดังภาพที่ 71 จะได้ Referenced 
Libraries ของระบบตามภาพที่ 72 

 
ภาพที่ 71 การน าเข้าจาร์ไฟล์ผลลัพธ์ 
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ภาพที่ 72 แสดงแพ็คเกจของจาร์ไฟล์ผลลัพธ์ 

5. หลังจากน าเข้าจาร์ไฟล์ผลลัพธ์ จะปรากฏ Referenced Libraries แพ็คเกจเพ่ือเรียกใช้งาน
ระบบ ทดสอบโดยการเรียกจากแพ็คเกจ th.ac.chula.eng.mda.coreprocess ดังภาพที่ 
73 

 
ภาพที่ 73 แพ็คเกจกระบวนการหลักส าหรับเรียกใช้งานระบบ 

6. สร้างคลาสหรือแพ็คเกจที่นักพัฒนาต้องการเรียกใช้งานระบบ ตัวอย่างการสร้างชื่อแพ็คเกจ  
th.ac.chula.eng.cp.systemTest ดังภาพที่ 74  

 
ภาพที่ 74 การสร้างคลาสเพ่ือเรียกใช้งานระบบจากจาร์ไฟล์ผลลัพธ์ 
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7. สร้างโฟลเดอร์ input และ output ส าหรับการใช้งานของระบบ  คลิกขวา New > Folder 
ดังภาพที่ 75 จะปรากฏตามภาพท่ี 76 ระบุค่า input และ output ตามล าดับเพื่อใช้งาน 

 
ภาพที่ 75 การสร้างโฟลเดอร์ input/output 

 
ภาพที่ 76 การระบุชื่อและพาธสร้างโฟลเดอร์ input/output 
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8. หลังจากสร้างโฟลเดอร์ input และ output  น าข้อมูลน าเข้าวางไว้ที่โฟลเดอร์ input เพ่ือใช้
ในการทดสอบระบบ เขียนโค้ดในคลาสที่ สร้ า งขึ้ นมา เ พ่ือทดสอบ โดย  Import 
th.ac.chula.eng.cp.mda.CoreProcess และสร้างตัวแปลเพ่ือเรียกใช้กระบวนการของ
ระบบ ดังภาพที่ 77 

 
ภาพที่ 77 ตัวอย่างการเขียนโค้ดเพ่ือเรียกใช้งานระบบ 

9. ท าการรันโปรแกรม จะได้ผลลัพธ์เป็นเอกสารเอกซ์เอ็มไอ และรายงานแสดงค่าสถิติ ที่
โฟลเดอร์ output



ภาคผนวก ข  
การใช้งานโปรแกรมโมเดลลิโอ 

 

 
ภาพที่ 78 โปรแกรมโมเดลลิโอ เวอร์ชัน 3.0.0 

 การใช้งานโปรแกรมโมเดลลิโอ เวอร์ชัน 3.0.0 ดังภาพที่ 78 เป็นโปรแกรมที่ใช้สร้างแผนภาพ 
ยูเอ็มแอลชนิดต่างๆ โดยงานวิจัยนี้ได้ให้ผลลัพธ์เป็นเอกสารเอกซ์เอ็มไอ เพื่อใช้กับโปรแกรมโมเดลลิโอ 
แสดงแผนภาพคลาสภาพรวมและรายละเอียดของระบบ หน้าจอการท างานหลักแสดงดังภาพที่ 79 

 

 
ภาพที่ 79 หน้าจอการท างานของโปรแกรมโมเดลลิโอ 
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1.) การสร้างแผนภาพใหม่ 

- เลือกที่แถบเมนูด้านบนดังนี้  File > Create  a project ดังภาพที่ 80 

 
ภาพที่ 80 การสร้างโพรเจกต์ 

- สร้างแผนภาพคลาส หลังจากสร้างโพรเจกต์ คลิกเลือก Create element > 
Class Diagram ดังภาพที่ 81 

 
ภาพที่ 81 การสร้างแผนภาพคลาส 
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2.) การวาดแผนภาพคลาสและส่วนประกอบ 

- คลิก diagram Class diagram จะแสดงแถบเครื่องมือ ดังภาพที่ 82 เลือก 
element ที่ต้องการและลากมายังหน้าจอการวาดแล้วตั้งชื่อคลาส 

 
ภาพที่ 82 การวาดภาพคลาส 

- เลือกส่วนประกอบของคลาสอ่ืนๆ โดยการเลือกแถบเครื่องมือทางซ้าย ลาก
มายังคลาสหรือหน้าจอการวัด ตัวอย่างเลือก Association ดังภาพที่ 83 

 
ภาพที่ 83 การวาดส่วนประกอบอื่นๆ 
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3.) การสร้างแผนภาพคลาสให้เป็นเอกสารเอกซ์เอ็มไอ 

- ที่แถบเมนู คลิกขวาที่คลาส เลือก XMI > Export XMI ดังภาพที่ 84 จะปรากฎ
หน้าจอดังภาพที่ 85 

 
ภาพที่ 84 การเลือกเมนู Export XMI 

- ระบุที่อยู่และตั้งชื่อไฟล์ที่ File path แล้วตั้งค่าต่างๆ ตามภาพที่ 85 แล้วคลิก 
“Export” 

 
ภาพที่ 85 หน้าจอ Export XMI 

4.) การน าเข้าเอกสารเอกซ์เอ็มไอเพื่อแสดงแผนภาพ 

- ที่แถบเมนู คลิกขวาที่คลาส เลือก XMI > Import XMI ดังภาพที่ 86 จะปรากฎ
หน้าจอดังภาพที่ 87 
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ภาพที่ 86 การเลือกเมนู Import XMI 

- ระบุท่ีอยู่และตัง้ชื่อที่ไฟล์ที่ File path ตามภาพท่ี 87 

 
ภาพที่ 87 หน้าจอ Import XMI



ภาคผนวก ค  
การส่งออกข้อมูลน าเข้าจาก Oracle Developer Tools และรหัสต้นทาง 

 

 การส่งออกข้อมูลชนิดฟอร์ม คลิกแถบเมนู File > Save as เลือก Save as Type: Forms 
(*.fmb) ตั้งชื่อรหัสที่ต้องการ ดังภาพที่ 88 

 
ภาพที่ 88 การส่งออกข้อมูลน าเข้าฟอร์ม 

การส่งออกข้อมูลชนิดไลบรารี คลิกแถบเมนู File > Save as เลือก Save as Type: PL/SQL 
Libraries (*.pll) ตั้งชื่อรหัสที่ต้องการ ดังภาพที่ 89 

 
ภาพที่ 89 การส่งออกข้อมูลน าเข้าไลบรารี 

การส่งออกข้อมูลชนิดไลบรารี คลิกแถบเมนู File > Save as เลือก Save as Type: Menus 
(*.mmb) ตั้งชื่อรหัสที่ต้องการ ดังภาพที่ 90 
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ภาพที่ 90 การส่งออกข้อมูลน าเข้าเมนู 

การส่งออกข้อมูลชนิดไลบรารี คลิกแถบเมนู File > Save as เลือก Save as Type: Report 
Definition (*.RDF) ตั้งชื่อรหัสที่ต้องการ ดังภาพที่ 91 

 
ภาพที่ 91 การส่งออกข้อมูลน าเข้ารายงาน 

 หลังจากส่งออกข้อมูล จะต้องการผ่านฟังก์ชันเสริม Form2XML เป็น  File BAT มีค าสั่งตาม
ภาพที่ 92 
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ภาพที่ 92 ค าสั่ง File BAT ของฟังก์ชัน Form2XML 

ขั้นตอนการเรียกใช้งานฟังก์ชัน น าข้อมูลน าเข้าที่ต้องการชนิดฟอร์ม, รายงาน และเมนู ไว้ใน
โฟลเดอร์เดียวกับ File BAT หลังจากนั้นพิมพ์ค าสั่ง Command Prompt  ชื่อ File BAT ตามด้วยชื่อ
ไฟล์ และนามสกุลไฟล์ ตัวอย่างตามภาพที่ 93 เป็นการแปลงไฟล์ทั้งหมดที่มีนามสกุล .fmb หลังจาก

แปลงส าเร็จ จะปรากฎข้อความ ตามภาพที่ 94 เอกสารเอกซ์เอ็มไอผลลัพธ์อยู่ในโฟลเดอร์เดียวกับ

ข้อมูลน าเข้า 

 
ภาพที่ 93 การเรียกใช้ฟังก์ชัน Form2XML 
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ภาพที่ 94 การแปลงเอกสารเอกซ์เอ็มแอลถูกต้อง 

 ตัวอย่างรหัสต้นทางน าเข้ารูปแบบเอกซ์เอ็มแอล  ที่ใช้ในการประเมินผลระบบบทที่ 5 

- CSMENU_MMB.xml  

 
ภาพที่ 95 รหัสต้นทางบางส่วนของ CSMENU_MMB.xml 
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- GBLM0110_FMB.xml  

 
ภาพที่ 96 รหัสต้นทางบางส่วนของ GBLM0110_FMB.xml 
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- GBLM0103_FMB.xml  

 
ภาพที่ 97 รหัสต้นทางบางส่วนของ GBLM0103_FMB.xml 
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- GBLM0120_FMB.xml  

 
ภาพที่ 98 รหัสต้นทางบางส่วนของ GBLM0120_FMB.xml 
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- SLTR0080_FMB.xml 

 
ภาพที่ 99 รหัสต้นทางบางส่วนของ SLTR0080_FMB.xml 
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- RECR0080_RDF.xml 

 
ภาพที่ 100 รหัสต้นทางบางส่วนของ RECR0080_RDF.xml 
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- SLTR0020_FMB.xml 

 
ภาพที่ 101 รหัสต้นทางบางส่วนของ SLTR0020_FMB.xml 
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- SLTR0020_RDF.xml 

 
ภาพที่ 102 รหัสต้นทางบางส่วนของ SLTR0020_RDF.xml 
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- MPL_CS_PLL.pld 

 
ภาพที่ 103 รหัสต้นทางบางส่วนของ MPL_CS_PLL.pld 
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- MPL_0002_PLL.pld 

 
ภาพที่ 104 รหัสต้นทางบางส่วนของ MPL_0002_PLL.pld



ภาคผนวก ง  
รหัสต้นทางผลลัพธ์เอกสารเอกซ์เอ็มไอ 

- XMIMenu_CSMENU.xmi 

 
ภาพที่ 105 รหัสต้นทางผลลัพธ์ของ XMIMenu_CSMENU.xmi 
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- XMIForm_GBLM0103.xmi 

 
ภาพที่ 106 รหัสต้นทางผลลัพธ์ของ XMIForm_GBLM0103.xmi 
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- XMIForm_GBLM0120.xmi 

 
ภาพที่ 107 รหัสต้นทางผลลัพธ์ของ XMIForm_GBLM0120.xmi 
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- XMIForm_SLTR0080.xmi 

 
ภาพที่ 108 รหัสต้นทางผลลัพธ์ของ XMIForm_SLTR0080.xmi 
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- XMIForm_SLTR0020.xmi 

 
ภาพที่ 109 รหัสต้นทางผลลัพธ์ของ XMIForm_SLTR0020.xmi 
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- XMIReport_RECR0080.xmi 

 
ภาพที่ 110 รหัสต้นทางผลลัพธ์ของ XMIReport_RECR0080.xmi 
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- XMIReport_SLTR0020.xmi 

 
ภาพที่ 111 รหัสต้นทางผลลัพธ์ของ XMIReport_SLTR0020.xmi 
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- XMILibrary_MPL_CS.xmi 

 
ภาพที่ 112 รหัสต้นทางผลลัพธ์ของ XMILibrary_MPL_CS.xmi 
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- XMILibrary_MPL_0002.xmi 

 
ภาพที่ 113 รหัสต้นทางผลลัพธ์ของ XMILibrary_MPL_0002.pld 
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- XMIOverAll.xmi   

 
ภาพที่ 114 รหัสต้นทางผลลัพธ์ของ XMIOverAll.xmi 
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ประวัติผู้เขียนวิทยานิพนธ์ 
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